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This instruction manual describes how to operate the TM10 Thermo-Collector.

m Intended Readers

This manual is primarily intended for two groups of readers: “operators’ who actually mea-
sure temperatures with this TM10 Thermo-Collector and, “engineers’ who are qualified to
perform setup and data processing operations for this instrument.

Structure of the manual
This manual is organized into the following four parts:

Information Required before Use

This part explains basic information, including the names and functions of each component
of this instrument and how to input characters, etc. Read this part before using this instru-
ment.

Preparation for Measurement

This part explains “ Thermo-Collector” software and how to perform setup. This part must be
read before starting preparation for temperature measurement.

Temperature Measurement

This part explains the major operations required to actually measure temperatures. Read this
part before commencing temperature measurement.

Utilizing the Measurement Data

This part explains the procedures for outputting the data measured with this instrument to a
personal computer or printer. Read this part to use or analyze the data measured with this
instrument.

Checking contents of the package
Perform a visual check on the TM 10 Thermo-Collector to make sure it is not damaged.

In addition, make sure that the following items have been supplied. If any of the items are
missing, please contact the dealer where this product was purchased.

Keep this box in case this product needs to be returned to Yokogawa M& C Corporation.

Iltem name Quantity
TM10 Thermo-Collector 1
“Thermo-Collector” software installer FD

LR6 akaline dry cell

Dust-proof seal (for sealing screw holes on the back of the main unit)
Instruction Manual (this document)
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m Precautions required for safe use

e About this manual

¢ Read this manual to gain a thorough understanding of this instrument before operating it.

« This manual only describes the functions of this product and is not intended to guarantee
the applicability of this product to user’s particular purpose.

« Thismanual shall not be reproduced or copied in part or in whole without permission from
Yokogawa M& C Corporation.

¢ The contents of this manual may be subject to change without notice.

« Should the user find any errors, or unclear or missing sectionsin this document, contact the
dealer where this product was purchased, or the marketing division of Yokogawa M&C
Corporation.

e Disassembly or retrofit

Do not disassemble or retrofit this instrument. Only qualified Yokogawa M& C Corporation
service personnel are authorized to disassemble and service the main unit.

e Precautions on handling
« Only parts and consumables specified by Yokogawa M& C Corporation should be used in
this product.
« Do not store thisinstrument in alocation where it will be subject to direct sunlight or high
temperatures, otherwise it may be discolored or deformed.

e Notes on protection and safety of this product

 Follow the safety instructions of this manual when handling the main unit or accessoriesto
be connected to the main unit. If the main unit or accessories are not handled as specified
in this manual, Yokogawa M & C Corporation cannot guarantee the safety of this product.

« The* /A Warni ng” mark that appears on the back of the main unit indicates the precautions
that must be observed when handling thisinstrument. Refer to this manual for information
about how to operate this instrument.

« Throughout this manual the following safety conventions are used.

A Warning

Used if the operator is at risk of being severely injured or killed.

A Caution

Used if the operator is at risk of being injured or if the instrument may be damaged.

AN Note

Used to draw attention to important information about handling the instrument or use-
ful information about the operations and functions of this instrument.
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[TIP]

Contains information supplementary to the main text.

See Also
Provides areference to related topics in this document.

m Precautions for handling components
Always observe the following precautions to avoid operator injury and damage to the equip-
ment.

e Probe

AN Warning

Do not point the tip of a needle-type standard probe or needle-type high-speed probe
at another person. The tip of the needle is very sharp and can cause injury.

A Caution

Do not touch the stylus (metal) of a probe which has just measured a hot object. A
hot stylus can cause a burn.

Do not use a worn or damaged probe. Such probes cannot measure temperatures
correctly.

Before removing the probe from the main unit, pull the probe away from the object
to be measured.

If a needle-type standard probe or needle-type high-speed probe is used, stick it
into ameasuring object half the dimension of the probe’s stylus (metal). If itis stuck
in too deeply, the operator may be burnt due to heat transfer to the probe grip. Also,
the probe itself may be damaged.

The probe grip and the cable connected to the main unit must be maintained at a
temperature between -20°C and 50°C. They have a small heat resistance, unlike the
stylus (metal) of the probe.

e Battery

A Caution

If this instrument will not be used for a long period, remove the battery from the main
unit. Otherwise, the battery liquid may leak and damage the main unit or cause it to
malfunction.

IM 54051-E



m Exemptions
* Yokogawa M& C Corporation does not guarantee this product in any way, except as set
forth in the terms and conditions of the certificate.

» Yokogawa M& C Corporation shall not be liable for any consequent or inconsegquent dam-
ages to the customer or athird party arising from the use of this product due to any defect
in materials or workmanship beyond the control of Yokogawa M& C Corporation.

m About the conventions used in the figures in this document

For understanding, figures in this document may be highlighted or simplified, or may have
portions omitted.

m Care of the main unit
« |If thereisaneed to clean the main unit, wipe the surfaces with awrung wet cloth.
» Use a cloth dampened with diluted neutral detergent to remove tough stains. Only use

neutral detergents. Do not use solvents or other detergents or chemicals. They may dam-
age the main unit.

» Keep connectors, etc., dry. Otherwise, the main unit may be damaged.

m Maintenance

If the main unit needs to be serviced, contact Yokogawa Engineering Service Corp. The
address is given on the back cover of this manual.

O Trademark
e “Microsoft”, “Windows”, and “Excel” are the trademarks or registered trademarks of
Microsoft Corporation.

* Corporate names and product names that appear in this document are the trademarks or
registered trademarks of their owners.
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1 Features of This Product

1 Features of This Product

This product is a handy-type thermometer that can measure a temperature and
make arecord of it. It has a “collector function” to record the measured tempera-
tures and measurement conditions under the specified tag, and a “logging func-
tion” to automatically measure and record temperatures at given intervals.

This section outlines each function.

m Collector function
The collector function is used when the measured temperature and measurement conditions
are recorded under the specified “tag”.
Inthe“tag”, thetag name(i.e. “what”), dateand time (i.e. “when"), operator name (i.e. “who”),
and alarm (i.e. “judgment on the measured data’) are recorded as the measurement condi-
tions, in addition to the measured temperature.

Tag name ("what")

[Burger] HiAlarm=+80.0 = LoAlarm=+60.0

___________________________________________________ Measurement temperature
No. Date Temp./—i/i Lo Person

00001 98/11/12/11:37:01 56.0 OK NG Smitp/—— Operator name ("who")
00002  98/11/12/11:37:01 575 OK NG  Smith
00003  98/11/12/11:37:027 585 OK NG _ Smith
00004  98/11/12/11:37:03  59.8 OK NG  Smith

00005  98/11/12/11:37:04 612 OK OK Smih ?Lf;?sured data judgment’)
00006  98/11/12/11:37:04 620 OK OK  Smith NG = No Good

00007  98/11/12/11:37:05 620 OK OK  Smith
00008  98/11/12/11:37:06  70.0 OK OK  Smith
00009  98/11/12/11:37:06 750 OK OK  Smith
00010  98/11/12/11:37:07  81.0 NG OK  Smith
00011  98/11/12/11:37:07 820 NG OK Smith

Date and time ("when")

Printout of image from a recommended printer

It ispossibleto use maximum 50 tags, and in these 50 tags, atotal of 5,000 pieces of tempera-
ture measurement data can berecorded. However, the morethe datais saved with thelogging
function, the less number of measurements can be made with the collector function.

Set up the following tag items in advance to use the collector function.
* Tag name
* Input channel
e Alarm
* Operator name

See Also
For more information, refer to the “Preparation for Measurement” part.

IM 54051-E
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1 Features of This Product

m Logging function

The logging function is used to automatically measure temperatures at given measurement
intervals and to continue to record theresult data. Thisfunction isuseful when atemperature
variation within a certain period of time (e.g. temperature variation in a refrigerator being
transported) needs to be recorded.

With this logging function, the temperatures and date (year/month/day) and time will be re-
corded as a “log”. Unlike the collector function, the logging function does not record the
operator name and alarm (measured data judgment).

Log name

[Convey ] Interval=00:00:10 Measurement interval

No. Date Temp.
00001 00/00/00/00:00:00 -10.5 Temperature
00002 00/00/00/00:00:10 -10.5 .
00003  00/00/00/00:00:20 /~ -11.0 Date and time
00004 00/00/00/00:00:30 -12.0
00005 00/00/00/00:00:40 -11.5
00006 00/00/00/00:00:50 -11.0
00007 00/00/00/00:01:00 -11.0
00008 00/00/00/00:01:10 -10.7
00009 00/00/00/00:01:20 -10.5
00010 00/00/00/00:01:30 -11.0
00011 00/00/00/00:01:40 -12.0 %

Printout of image from a recommended printer

It is possible to use maximum 10 logs, and in these 10 logs, a total of 20,000 pieces of data
can be recorded. However, the more the data is saved with the collector function, the less
number of measurements can be made with the logging function.

Set up the following itemsin advance to use the logging function.
* Log name
¢ Input channel
¢ Measurement interval
* Measurement period

See Also
For more information, refer to the “Preparation for Measurement” part.
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2 Names and Functions of Each Part

2 Names and Functions of Each Part

O
Top face Front face
&
TMID %
V3 — 0O
S
O
'YOKOGAAR® | D
+— O
QG
O
. )
Bottom face &) @3 &= %
ONONO}
= ® O @ & wenc
D D RS232C QRS .vw v @
O L ==
®
@® External probe connection jack (channelA) | @ [V][A] key
Used to connect a needle-type standard probe, a Used to select an appropriate tag, log, or function.
needle-type high-speed probe, or other probes. [LOGGING] key
@ Radiation temperature probe connec- Used to switch between the collector and logging
tion jack (channel D) functions. Also used to modify alphanumeric char-
Used to connect a radiation thermometer. acters from uppercase to lowercase.
® RS-232C communication connection | @ [POWER] key
terminal Used to turn the power supply on and off.
Used to output data from this instrument to a per- [Set] key
sonal computer or printer. Used to make the setup contents valid for operation.
@ Built-in sensor (channel C) [Func] key _
Used to measure the external temperature. Used to set up the selected function.
. Also used to delete the measurement data.
® Display (LCD) 1 9 4101 k
Displays Thermo-Collector conditions, various setup [1]....,[9], and [0] keys
information, measurement temperature, etc. Used to enter alphabets and numbers.
’ p S The[0] key isalso used for switching the unit of tem-
® [CH] key perature display. If, for example, this [0] key is
Used to switch the current input channel. Available pressed in the Home screen, the unit is switched to
input channels include channel A (for probes), chan- thz unﬁqgtbfé,!)r& ng of the same key will restore
nel -C Ffor the built-in sensor), and channel D (for the ® [<] and [>] keys
radiation temperature probe). Used to retrieve the logged tag data or log data, or to
@ [ESC] key select the character input position.
Used to cancel the previous operation and return to Battery compartment
the previous screen. Accommodates two LR6 alkaline dry cells.
[Memory] key @ Name plate

Used to commence a temperature measurement with
either the collector function or the logging function.

IM 54051-E
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3 Setting the Battery

3 Setting the Battery

Two LR6 alkaline dry cells are included with this instrument.

1. Open the battery compartment cover at the back of the main unit.

See Also
For information about the position of the battery compartment, refer to “2 Names and Functions of
Each Part”.

2. Observing the correct polarity, install the two LR6 alkaline dry cells in the battery com-
partment.

A Caution

Observe the correct polarity when installing the batteries in the battery compartment.
The main unit may be damaged if the batteries are installed incorrectly.

3. Closethe battery compartment cover.

-End of procedure-

A Caution

Remove old batteries from the compartment. Battery liquid leakage may cause the
main unit to malfunction or may damage it. A “BatteryEmpty” message will appear on
the LCD shortly before the battery life expires. When this message appears, replace
the batteries.
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4 Turn ON/OFF of the Power Supply

4 Turn ON/OFF of the Power Supply

m Turn the power supply to ON

Press the [POWER] key.
After the“TM10 Ver. 1.00”, “Initial Test”, and “Initial OK” messages have been displayed, the time display screen
appears on the LCD.

a
INPUT v AUTO OFF

" 19:13:15

The power of the main unit is turned on.
m Turn the power supply to OFF

Hold down the [POWER] key for about three seconds.
The power to the main unit will be shut down after a short beep has been sounded.

IM 54051-E
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5 Screen (LCD) Displays

5 Screen (LCD) Displays

:
ERon (A=) .
u%;;; 12:30:00] .
—mr028.5°C

® Indicates that the chime function is being set.

©) Indicates whether the current mode is the collector mode or logging mode. Ifis
displayed, the current mode is the logging mode. If it is not displayed, the cur-
rent mode is the collector mode.

® Indicates the input channels currently used for measurement.

0) Indicates that the measurement data is being logged into the instrument.

® Indicates that the alarm is set.

® Indicates that either the [<] or [>] key can be used.

©) Indicates that either the key lock or FUNC lock is set. If the key lock function is
on, all the keys are disabled. In the FUNC lock state, only the temperature mea-
surement keys can be used.

See Also

For information about canceling the lock state, refer to “5 Other Useful Functions” in the “ Tempera-
ture Measurement” part.

®

@
@)

[TIP]

Indicates that the battery is almost used up. Replace the battery as soon as
possible after this symbol is displayed.

Indicates that the instrument is set so that the power to the main unit will be
automatically turned off if no operation is made in a predetermined period of
time.

Indicates that either the [ A] or [ ¥] key can be used.
Indicates that the timer function is on and the instrument is in the wait state.
A tag name, log name, and temperature will be displayed.

If this instrument is used in a location where the ambient temperature is low, the characters may be
displayed slowly. Note that this does not indicate the main unit being at a malfunction.
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6 How to Input Characters

6 How to Input Characters

This section explains the character input procedure. Alphabets and numbers can

be entered.

The procedure used to input characters into Thermo-Collector is similar to the

method used to enter characters in a cellular phone.

m Entering characters

Usethe ® to ® keysto enter characters. These keys are also used to enter al phabets.
For example, the @ key can be used to enter “A” to “C”, and “2". To enter “C”, pressthe @

key three times.
To enter “2", press the @ key four times.

Mode .
Key Alphanumeric input mode
@ 1

) ¢ “A+B-C=2- -
) ¢ “D—-E—-F-=3~ -
@, ¢ *GoH->14- o
®, ¢ #I-KoL=5- -
@MNO ¢ *M>N=0-6~ -
O (*P>Q+R—>S~7-1
uv ( >T>U=>v=8—>
@VXYZ (WX Y >Z+9y
@ymbol L R e R R e

m Entering lowercase characters

1. Enter acharacter to be made small.
A )
A
[NewTag]

2. Position the cursor on the character and press the [LOGGING] key.

This character is made small.

INPUT

LA

a

)
[NewTagJ

- End of procedure

IM 54051-E
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1 Overview of Preparation for Measurement

1 overview of Preparation for Measurement

Before measuring temperatures, set the tag names, etc., on the main unit.

There are two methods for making the settings. One is for the main unit and the
other is for a personal computer. For efficiency, use a personal computer to set
many items.

O Setting up the main unit
« Setting the date and time
« Setting the name of the main unit

Setting up the main unit Setting up the personal computer

OSet up the following O Set up the following

« Collector function » Collector function
Tag name, input channel, alarm, Tag name, input channel, alarm,
and operator name and operator name

* Logging function * Logging function
Log name, input channel, Log name, input channel,
measurement interval, measurement interval,
and measurement period and measurement period

I

O Transmit the following data
 Setup data
¢ Operator name

[ OMeasure the temperature

() : setup to be performed in this part
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2 Setting Up the Main Unit

2 Setting Up the Main Unit

2.1 Setting the date and time

Home screen

7'y
INPUT v

| 18:54:27
25.9°C

[TIP]

This screen which displays the current timeis
referred to asthe“Home” screen. All thefunc-
tions in the main unit are accessed from this
screen.

1. Press the [FUNC], [6], and [1] keys, in
this order.
The “Time setting” screen will appear on the LCD.

a
INPUT v

| F61
ClockSet

2. Press the [SET] key.
A screen for setting the date will appear on the LCD.

)

INPUT

| Date

98/11/11

3. Enter the date.

See Also

For information about entering a character or
number, refer to “6 How to Input Characters”
inthe“Information Required before Use” part.

4. Press the [SET] key.

A screen for setting the time will appear on the LCD.

)
. Time

18:56:14

Enter the time.

Press the [SET] key.

The specified timeis set.

a
INPUT v

|, F61
ClockSet

Pressthe [ESC] key repeatedly to return to the Home
screen.

-End of procedure-

IM 54051-E
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2 Setting Up the Main Unit

2.2 Setting the name of the | 4. Press the [SET] key.

Theinstrument name is set.

main unit The “Name” screen will be restored.
If more than one Thermo-Collector is used o :
at atime, aunique name must be set for each. =-c FO7
(TP Name

Make this setting as necessary.

Pressthe [ESC] key repeatedly to return to the Home

Home screen screen.

a -End of procedure-
r&PUT '
| 18:54:27

25.9°C

1. Press the [FUNC], [9], and [7] keys, in
this order.
The “Name” screen appears on the LCD.

a
INPUT v

| F97
Name

2. Press the [SET] key.
ﬁwur < >
| DevName

Name0O0

3. Enter the name of the instrument (Ex-
ample: NO1).

INPUT < >
i. DevName

NO1

See Also

For information about entering a character or
number, refer to “6 How to Input Characters’
inthe* Information Required before Use” part.

IM 54051-E

10



3 Setting Up with the Main Unit

3 Setting Up with the Main Unit

3.1 Setups required to use the collector function
(Setting the tag name, input channel, alarm, and operator name)

Before using the collector function, the following tag setups must be made.

m Setup contents

e Tag name
Put atitle for each tag.
e Input channel

Thermo-Collector has multiple input channels and probes for measuring temperatures of
substances in a vapor, solid, or liquid phase. Since the probe to be used depends on the
measuring object, it is necessary to set the available input channel on atag in advance.
The following table shows the probe types and their corresponding input channels.

Probe type Input channel
Standard needle probe
High speed needle probe

Surface probe A

Rounded end probe

Built-in sensor C

Emission thermo probe D
e Alarm

Set alimit temperature at which the alarm sounds.

* ON/OFF of the upper-limit alarm and upper-limit temperature
Make the following settings to sound an alarm when the temperature rises above a preset limit.
The upper-limit temperature cannot be set if the alarm function for the upper limit is set to OFF.

Setting the upper-limit alarm to ON and the upper-limit temperature to 70°C

Temperature

: Range in which the alarm sounds.

IM 54051-E
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3 Setting Up with the Main Unit

* ON/OFF of the lower-limit alarm and lower-limit temperature

Make the following settings to sound an alarm if the temperature falls below a preset limit.
The lower-limit temperature cannot be set if the alarm function for the lower limit is set to OFF.

Setting the lower-limit alarm to ON and the lower-limit temperature to 50°C

Temperature

: Range in which the alarm sounds

* Inverse alarm function ON/OFF
The settings of the alarm function can be inverted.

Specificaly, if thisinverse alarm functionsis set to ON, an alarm will sound if the temperaturefalls
below the upper limit or if the temperature rises above the lower limit.

If “OFF” If “ON”
Upper-limit alarm 70°C Upper-limit alarm 70°C
Lower-limit alarm 50°C Lower-limit alarm 50°C
Temperature Temperature
70°C. [HESSESITIIsITstaL T0°Cf-mmmmmm e
10 o N 50°C|P———

: Range in which the alarm sounds

[TIP]

The alarm can also be set to turn off if the temperature exceeds the upper limit, or it can be set to turn
on if the temperature falls between the upper and lower limits.

e Operator name
Set the name of the operator.

See Also
For information about setting the operator name, refer to “m Registering the measurement operator
name”.

IM 54051-E
12



3 Setting Up with the Main Unit

m Creating a new tag

Create new tags for recording the measure-
ment data.

Home screen

a
INPUT v

| 18:54:27
25.9°C

1. Press the [FUNC], [1], and [3] keys, in
this order.
The “Ins” screen will appear on the LCD.

a
INPUT v

* F13
Tag Ins

2. Press the [SET] key.
A screen for selecting the tag name will appear.

INPUT v

" Burger

0

[TIP]

If no tag has been created in the main unit,
[NewTag] is displayed on the screen.

3. Press the [v] key repeatedly until
[NewTag] is displayed on the screen.

a

INPUT

" [NewTag]
0

4. Use the [CH] key to select the input
channel.
The input channel of the [INPUT] gage changes.

a

INPUT

| [NewTag]
0

5. Press the [SET] key.
A screen for entering a new tag name will appear.

INPUT )
1
i

) [NewTag]

[TIP]

If anew tag is created while [NewTag] isdis-
played, the created tag will be added to the end
of thelist. If the [SET] key is pressed while
[NewTag] isnot displayed, the created tag will
beinserted immediately before the selected tag.

6. Enter the tag name.
WPUT ( )
. Convey

[NewTag]

[TIP]

A tag name can consist of amaximum of eight
aphanumeric characters.

See Also

For information about entering a character or
number, refer to “6 How to Input Characters”
inthe* Information Required before Use” part.

IM 54051-E
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3 Setting Up with the Main Unit

7

14

. Press the [SET] key.

A screen for confirming the entered contents will ap-
pear.

INPUT

. Insert?

Yes1/NoO

Press the [1] key.
A new tag will be created.

a
ot v

. Convey

0

Pressthe [ESC] key repeatedly to return to the Home
screen.

-End of procedure-

Setting the alarm function for
each tag

The alarm function can be set according to
different tag conditions, or the same alarm
function can be set for all tags.

The following procedure is used to set the
alarm function for different conditions.

See Also

To set the same alarm function for al tags, pro-
ceed to “m Batch-setting the alarm function”.

Home screen

| 18:54:27

25.9°C

Press the [FUNC], [7], and [2] keys, in
this order.
The “1File” screen will appear on the LCD.

a
INPUT v

| F72
1File

Press the [SET] key.
A screen for selecting a tag name will appear.

INPUT v

. Convey

0

Press the [ ¥] key repeatedly until a tag
name for which the alarm is to be set
appears on the screen.

Press the [SET] key.
A screen for setting the alarm HIGH function ON/
OFF will appear on the LCD.

a
INPUT v

| Hi Alarm

ON

Use either the [ v] or [ A] key to set the
upper-limit temperature alarm function
ON/OFF.

If ON has been selected, press the [SET]
key.

The “Hi Alarm” setting screen will appear on the
screen.

If OFF has been selected in step 5, this screen will
not appear. In this case proceed to step 8.

a
INPUT '>

i Hi Alarm

+000.0°C

IM 54051-E



3 Setting Up with the Main Unit

7. Enter the upper-limit temperature. 11. Enter the lower-limit temperature.
INPUT ¢> INPUT <¢
1 . 1
I Hi Alarm . Lo Alarm
0 0
+020.0°C +020.0°C
[TIP] [TIP]
To set anegative value, press either the [ v] or To set anegative value, press either the[ v] or
[ A] key. The “+” symbol on the screen will [ A] key. The “+" symbol on the screen will
changeto a“-" symbol. changeto a“-" symbol.
See Also _ 12 press the [SET] key.
For information about entering a character or The specified lower-limit temperature is set and the
number, refer to “6 How to Input Characters” “Inverse alarm function” screen will appear on the
inthe* Information Required before Use” part. screen.
s
8. Press the [SET] key. "
The specified upper-limit temperature is set and the =-c Tu 'n

screen to set the “Lo Alarm” function ON/OFF will

appear on the screen. O F F

a
INPUT '
1
I Lo Alarm 13.use either the [¥] or [a] key to select
c whether the operation of the alarm func-
O N tion is to beinverted. If ONis selected,

the alarm function will operate under the
inverse conditions.

9. Use either the [v] or [A] key to set the
lower-limit temperature alarm function 14 press the [SET] key.

ON/OFE. The range in which the alarm sounds will be dis-
played.
Then, th f firming the setti ill ap-
10. If “ON” has been selected, press the pe:rr_]’ © Screen for contirming the Setting witl ap
[SET] key.
The “Lo Alarm” setting screen will appear on the )
screen. W
If “OFF" has been selected in step 9, this screen will l, Ch ange?

not appear. In this case proceed to step 12.

0y Yes1/NoOQ
| Lo Alarm 15 prese e 41
+ O 0 0 . 0 0 C .Tl:ee:IZrm f?JrEcti]onSv}i/I.l be set for each tag.

Pressthe [ESC] key repeatedly to return to the Home
screen.

-End of procedure-

IM 54051-E
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3 Setting Up with the Main Unit

m Batch-setting the alarm function

The following procedure is used to set the
same alarm function for all tags.

Home screen

| 18:54:27

25.9°C

1. Press the [FUNC], [7], and [1] keys, in
this order.
The “All File” screen appears on the LCD.

a
INPUT v

i F71
All File

2. Press the [SET] key.
A screen for setting the alarm HIGH function ON/
OFF will appear.

a
INPUT v

i Hi Alarm

ON

3. Use either the [v] or [A] key to set the
upper-limit temperature alarm function

ON/OFF.

4. If ON has been selected, press the [SET]
key.
The “Hi Alarm” setting screen will appear on the
screen.

If OFF has been selected in step 3, this screen will
not appear. In this case proceed to step 6.

&
INPUT '>

i Hi Alarm

+000.0°C

Enter the upper-limit temperature.
INPUT <¢

| Hi Alarm

+020.0°C

[TIP]

To set anegative value, press either the[ v] or
[ A] key. The “+" symbol on the screen will
changeto a“-" symbol.

See Also

For the method of entering a character or num-
ber, refer to “6 How to Input Characters’ in
the “Information Required before Use” part.

Press the [SET] key.

The specified upper-limit temperature is set and the
screen of selecting ON/OFF of the“Lo Alarm” func-
tion will appear on the screen.

A
INPUT v

| Lo Alarm

ON

. Use either the [ ¥] or [ A] key to select

ON/OFF of the lower-limit temperature
alarm function.

. When ON has been selected, press the

[SET] key.
The “Lo Alarm” setting screen will appear on the
screen.

If OFF has been selected in step 7, this screen will
not appear. In this case proceed to step 10.

a
INPUT '>

| Lo Alarm

+000.0°C

16
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3 Setting Up with the Main Unit

9. Enter the lower-limit temperature.
INPUT <¢

| Lo Alarm

+020.0°C

[TIP]

In order to set a negative value, press either
the [v] or [ A] key. The “+” symbol on the
screen will changeto a“-" symbol.

10.Press the [SET] key.
The specified lower-limit temperature is set and the
“Turn” screen will appear on the screen.

a
INPUT v

i Turn
OFF

11.use either the [v] or [A] key to select
whether the operation of the alarm func-
tion is to be inverted. If ONis selected,
the alarm function will operate under the
inverse condition.

12. press the [SET] key.

Therangein which the aarm sounds will be displayed.
Then, the screen for confirming the settings will ap-

pear.
$
I. Change?

Yes1/NoO

13.press the [1] key.
The range in which the alarm function is active will
be set for all tags as a batch.

Pressthe [ESC] key repeatedly to return to the Home
screen.

[TIP]

If another alarm function is batch-set for all
tags after one alarm function has been batch-
set, only the latest one will be effective.

-End of procedure-

m Registering the measurement

operator name
Home screen

a
INPUT v

| 18:54:27
25.9°C

1. Press the [FUNC], [8], and [3] keys, in
this order.

a
INPUT v

| F83
Entry

2. Press the [SET] key.
A screen for registering an operator name will ap-

<»

3. Press the [v] key repeatedly until a
number assigned to the operator name
to beregistered appears on the screen.

a
v

INPUT

Lo 2

[TIP]

Each operator name is assigned a unique reg-
istration number. A maximum of ten operators
can be registered in the main unit.

See Also

For information about entering a character or
number, refer to “6 How to Input Characters’
inthe* Information Required before Use” part.

IM 54051-E
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3 Setting Up with the Main Unit

18

Press the [SET] key.

Enter the operator name with a maxi-
mum of eight characters.

bl >
Lo 2

See Also

For information about entering a character or
number, refer to “6 How to Input Characters’
inthe* Information Required before Use” part.

Press the [SET] key.
The screen for confirming the settings will appear.

INPUT

| Entry?
Yes1/NoQ

Press the [1] key.

The specified operator name has been set.

Pressthe [ESC] key repeatedly to return to the Home
screen.

-End of procedure-
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3 Setting Up with the Main Unit

3.2 Setups required to use the logging function

(Setting the log name, input channel, measurement interval,
and measurement period)

Before using the logging function, it is necessary to make logs settings.
m Setup contents

e og name
Put atitleto each log. A log name can consist of a maximum of eight al phanumeric charac-
ters.

e Input channel
Thermo-Collector is provided with multiple input channels and probes for measuring tem-
peratures of substances in a vapor, solid, or liquid phase. Since the probe to be used de-
pends on the measuring object, it is necessary to set the available input channel on atagin
advance.

The following table shows the probe types and their corresponding input channels.

Probe type Input channel
Standard needle probe
High speed needle probe

Surface probe A
Rounded end probe

Built-in sensor C
Emission thermo probe D

e Measurement interval

Set aninterval at which the temperatureis periodically measured. Theinterval can be setto
between 1 second to 24 hours.

e Measurement period

Set a period through which the temperature is measured continuously. The period can be
set to between 1 second to 999 days.

IM 54051-E
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3 Setting Up with the Main Unit

m Operation procedure

Home screen

a
INPUT v

| 18:54:27
25.9°C

1. Press the [FUNC], [2], and [3] keys, in

this order.
The “Ins” screen will appear on the LCD.

a
INPUT v

" F23
Log Ins

2. Press the [SET] key.
A screen for selecting the log name will appear.

INPUT v

" Acceptl
0

[TIP]

If no log has been created in the main unit,

[NewL og] is displayed on the screen.

3. Press the [v] key repeatedly until

[NewLog] appears on the screen.
a

INPUT

B [NewLog]
0

4. use the [CH] key to select the input

channel.
The input channel of the [INPUT] gage changes.

a

INPUT

|, [NewLog]
0

Press the [SET] key.
A screen for entering a new log name will appear.

INPUT >
1

|
lc

[NewLog]

[TIP]

If anew log is created while [NewLog] isdis-
played, the created log will be added to the end
of the list. If the [SET] key is pressed while
[NewL og] isnot displayed, the created log will
beinserted immediately beforethe selected log.

. Enter the log name.

¢
L. Accept2

[NewLog]

[TIP]

A log name can consist of amaximum of eight
aphanumeric characters.

See Also

For information about entering a character or
number, refer to “6 How to Input Characters’
inthe“ Information Required before Use” part.

20
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3 Setting Up with the Main Unit

7. Press the [SET] key.

A screen for setting the measurement interval will appear.

INPUT )
. Interval

00:00:10

Enter the hour, minute, and seconds.
INPUT (

1

. Interval

01:15:30

[TIP]

The definition and range of each input valueis
given below.

00:00:00

Indicates the seconds.

The input range is between 0
and 59 seconds

Indicates the minutes.

The input range is between 0
and 59 minutes

Indicates the hours.

The input range is between 0
and 24 hours.

Press the [SET] key.

The specified measurement interval is set and the
screen for setting the measurement period (select the
number of daysfrom the options, which also includes
the number of hours, minutes, and seconds) will be

displayed.

)
| ProdDay

002

10. Enter the number of days.

11.

12.

13.

14.

Press the [SET] key.

The screen for setting the measurement period (select the
number of hours, minutes and seconds from the options,
which aso includesthe number of days) will be displayed.

INPUT )
| ProdTime

00:00:00

Enter the number of hours, minutes, and
seconds.

INPUT (
| ProdTime

01:30:00

[TIP]

The definition and range of each input value
are given below.

00:00:00

Indicates the seconds.

The input range is between 0
and 59 seconds

Indicates the minutes.

The input range is between 0
and 59 minutes

Indicates the hours.

The input range is between 0
and 23 hours.

Press the [SET] key.
The screen for confirming the settings will appear.

INPUT

. Insert?

Yes1/NoO

Press the [1] key.
The specified measurement period has been set.

a
INPUT v

| Accept2
0

Pressthe [ESC] key repeatedly to return to the Home
screen.

-End of procedure-

IM 54051-E
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4 Setting Up with the Personal Computer

4 Setting Up with the Personal Computer

4.1 Setting up the “Thermo-Collector” software

The setup operation required for the main unit can be performed on a personal computer.
The “Thermo-Collector” software must be used to do this. This section explains the proce-
dure used to set up the “ Thermo-Collector” software on the personal computer.

Connecting the personal computer and the main unit

|
Installing the “Thermo-Collector” software on the personal computer

|
Confirming the communication environment (on the personal computer)

!

Confirming the communication environment (on the main unit)

m Connecting the personal computer and the main unit
Purchase an RS-232C cable (Model name: 910 09, round DIN 8-pin to D-sub 25-pin type).
Follow the procedure below to connect the main unit to the personal computer.

1. Turn off the power to both the personal computer and main unit.

2. Connect the personal computer and the main unit as shown in the following diagram.

[]l_

Personal computer

Dedicated cable (Model name: 910 09)

Connection between connector pins
(Round DIN 8-pin to D-sub 25-pin)

A

e

Bottom of the Serial port of the personal 6 (N.C)
main unit (8-pin) computer (with 25-pin connector)

Plug this cable into the connector so that the
“<" mark on the grip faces downward.

NNWAaN A

1
2
3
4
7
8
5,

OV iy

IM 54051-E
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4 Setting Up with the Personal Computer

[TIP]

If the personal computer has a 9-pin type serial port, a25-pin to 9-pin conversion connector isrequired
(RS-232C conversion adapter, D09-9F25F (Manufacturer: Sanwa Supplies Corp.) is recommended).

3. First turn on the power to the main unit, then turn on the power to the personal com-
puter.

-End of procedure-

m Installing the “Thermo-Collector” software

Install the “ Thermo-Collector” software on the personal computer. The two floppy diskettes
that come with the main unit are required for this installation.

1. Place a floppy diskette (Setup Disk #1) in the floppy disk drive of the personal com-
puter.

2. Double-click on the * My Computer” icon.
The “My Computer” folder will be displayed.

& My Computer _ (O] x|
File Edit “iew Help

= = =

Vi Win95e (C) Temporary [D:)

H B =

[E:] Contral Panel Printers

| E object(s] | &

IM 54051-E
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4 Setting Up with the Personal Computer

3. Double-click on the floppy disk drive icon (A:drive in the case of a DOS/V machine).

File Edt “iew Help
2

AgpcFildl  MSVEYME0.. Oleduw32dl OlePro32d_

Setup

Setup.lst setupl.ex_ StdOle2.t_ WBESHKitd_

110 nhject(s) |1 38MB i

4. Double-click on * Setup”.
The Setup isinitiated and a screen prompting the insertion of the second floppy diskette (Setup Disk #2) will appear.

Setup E3
Please insert the disk labeled:
‘Disk 2'inkto drive A%

| Cancel |

5. After inserting the second floppy diskette (Setup Disk #2), click on the [OK] button.
Precautions to be observed prior to installation will appear.

Therma Collector Setup

g “WWelcome ta the Thermo Collectar installation program.
=

Setup cannat install system fles or update shared files i they are in use
Bicfore proceeding, we recommend that you clase any applications you may
be running,

I | Euit Setup

6. Click on the [OK] button.
Theinstaller of the application program is initiated and the “Thermo Collector Setup” screen will be displayed.

[Start Setup] button

#2 Thermo Collector Setup

Begin the installatigf by clicking the button below.

Click thiz button to install Thermo Collector software to the specified destination
directory.

Directory:
’VC.\F'ruglam Files\Thermeo Collectar', Change Directory | |

Esit Satup

IM 54051-E
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7. Click on the [Start Setup] button.
[TIP]

Do as follows to change the application install destination.
1.Click on the [Change Directory] button.
2.Select ainstallation destination folder.
3.Click on the [OK] button.

After installation has been completed, the following confirmation window is displayed.
Thermo Collector Setup =

Themo Callectar 5etup was completed successhully

8. Click on the [OK] button.

-End of procedure-

m Confirming the communication environment (on the personal computer)
Confirm the settings related to the communication environment on the personal computer.

1. select “Thermo-Collector” in the “Programs” accessed from the “Start” menu.

2. Select “Properties” from the “Comm” menu.
The “Properties” window will be displayed.

CommPort 1 T |
Baud Rate 9500

cancel
Party None

Data Bits Bhit

J I [ I

Stop Bits it

3. Confirm that the settings are exactly as shown in the above figure.
If any of the settings are different, set them to the values given below.

Setup item Setting value
CommPort 1

Baud Rate 9600

Parity None

Data Bits 8

Stop Bits 2

[TIP]

The communication port setting values vary, depending on the type of personal computer. For more
information, refer to the manual supplied with your personal compuiter.

-End of procedure-

IM 54051-E
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4 Setting Up with the Personal Computer

26

Confirming the communication
environment (on the main unit)
Confirm the settings related to communica-
tion environment on the main unit. Con-
firm that the settings are exactly as shown
in the following table.

If any of the settings are different, set them
to the values given below.

Setupitem  Setting value (Factory Settings)
Baud rate 9600

Parity None

Data Length 8hit

Stop bits 2bit

Flow control None

Home screen

s

i, 18:54:27

25.9°C

Press the [FUNC], [5], and [1] keys, in
this order.

A screen for setting the communication environment
will appear on the LCD.

a
INPUT v

| F51
Comm Set

Press the [SET] key.

A screen for setting the baud rate will appear on the
LCD. Thedisplayed baud rate is 9600 bps, which is
factory setting.

a
INPUT v

| Baudrate
9600

Press the [SET] key.
A screen for setting the parity will appear on the LCD.
The displayed parity is None, which isfactory setting.

{C Parity
None

Press the [SET] key.

A screen for setting the datalength will appear on the
LCD. Confirm that the displayed data length is as
shown in the following figure.

a

INPUT

| Data Len
8hit

Press the [SET] key.

A screen for setting the number of stop bits will ap-
pear on the LCD. The displayed number of stop bits
is 2 bits, which is factory setting.

a

INPUT

| Stop Bit
2bit

Press the [SET] key.

A screen for setting the flow control method will ap-
pear onthe LCD. The displayed flow control method
is None, which is factory setting.

A
INPUT v

| Flow
None

Press the [SET] key.
Returns to the communication environment setup screen.

a
INPUT v

| F51
Comm Set

Pressthe [ESC] key repeatedly to return to the Home
screen.

-End of procedure-
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4.2 Basic operation of Thermo-Collector software
This section explains the basic operation of the supplied software.
m |nitiating Thermo-Collector software

E Open Office Document

qﬁ Accessoies
q;ﬁ Startlp:

¢ 2% Microsoft Excel

& Microsoft Photo Editor
, HE 13-00S Prompt

-

3 | Windows 95

Select “Thermo-Collector” in the “Programs” accessed from the “Start” menu.
After the main screen of the software is displayed, the “ Setup Tags/Logs - New” screen will be displayed.

’ Thermo Collector _ O] x|

File Comm Edit “iew Help

T | 3 BllE] o X

Tags |Logs |

Mo. | Mame [ Channel [ Hi Temnperature [ HiAlarm [ Lo Termperature | Lo Alarm [ Turn Alarm [«

[ EGEE [234PM 7

IM 54051-E
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4 Setting Up with the Personal Computer

m Terminating Thermo-Collector software

4 Thermo Collector O] x|

Comm Edit Wiew Help

Setup Tags/Logs : B B E @l Elmélgl ﬂ X E]_,E]ll

Setup Persong
Measired Datas F

Select “Exit” from the “File” menu.

m Saving the setup datain afile

’ Thermo Collector M= E3
Comm Edit Wiew Help

Setup Tags/Logs Chil+N g o2 B

Setup Persons > Chrl+0 = § o | X E] ﬂll

easired Detas ¥

Exit

‘ Mo. Mame 1]

re [ HiAlarm [ Lo Temperature [ Lo Alarm [ Tum Alarm [«
1 Frirt... Chrl+F

1. select“save” in the Setup Tags/Logs” menu accessed from the “File” menu.
The “Save As” window will be displayed.

Save As HE
Save jn: I E4 Thermo Collector j rj(l

File name: |CDLLECTDH| Save I
Save az hype: ITM Tags/Logs Files [*.tmt] ﬂ Cancel |

2. Enter afile name in the “File name” field, then click on the [Save] button.
The setup data will be saved.

-End of procedure-
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m Loading a file containing the setup data
|

Comm  Edit Wiew Help
5 Hew

Setup Personz 3
I easired [Etas ¥

Cirl+h

EB.&

Save Ctrl+5
Exit Save Az
Mo. [ Mame | Gend
1 Erirt.. Chrl+P

EEAEEY

e | Hi Alarm | Lo Temperature | Lo Alarm | Turn Alarm ﬂ|

1. select “Open” in the “Setup Tags/Logs” menu accessed from the “File” menu.

The “Open” window will be displayed.

Open

Look in:

Ia Therma Callector

Filz hame:

|COLLECTOR

Dpen I

Files of type: [ TH Tags/Lags Fies [*mt)

j Cancel |

2. Select afile to be loaded, then click on the [Open] button.
The specified file containing the setup datawill be loaded, and the tag and | og setup datain the filewill be displayed.

’ Thermo Collector _[O] %]
File Comm  Edit Wiew Help
Tags |Logs |
ka. Mame |Channe| Hi Temperature | Hi Alarm | Lo Temperature | Lo Alarm | Turn Alarm [«
1 fBurger oM +0B0.0| OM ON
B
EE
L2
3
L& ]
IS
S|
LY |
10 -
[ EGEEE (734 PM o
-End of procedure-
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m Saving the measurement operator name data

The operator data will be saved in afile different from that in which the tag and log datais
stored.

’ Thermo Collector | 10] x|

Comm  Edit Wiew Help
il 2] ] 4

Selup Tags/Logs + | [ o | o [

Setup P 3 3 HNew
IEasuEn DatassF Open... 10R_tmt
IS E3
Exit
Mo, 11 mmperature | Lo Alarm | Turn Alarm | =
1 2 — +060.0 oM ON
7 = Send
3 T Frirt

1. select “save” in the ® Setup Persons” menu accessed from the “File” menu.
The “Save as” window will be displayed.

Save As m
Savein IaThermn Collector j il

File name: IpersonZ Save I
Save as type: ITM Persons File (*ptr) LI Cancel

2. Enter afile name in the “File name” field, then click on the [Save] button.
The measurement operator name data being set will be saved.

-End of procedure-

IM 54051-E
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m Loading the measurement operator name file
’ Thermo Collector [_[O] ]

3 comm Edit Wiew Help
il e ) R A [

Setup Tags/Logs P |l e | |

Ieasired Vetas

Exit Save
SavE g
Eeri= perature | Hi Alarm | Lo Temperature | La Alarm | Turn Alarm [«

Send
Bt

1. select “Open” in the “Setup Persons” menu accessed from the “File” menu.
The “Open” window will be displayed.

Open 7] %]
Laok jn: Ia Therma Collector j |‘j(| &

File name: |person Open I
Filez of tupe: ITM Perzons Files (% ptm] ﬂ Cancel |

2. Select afile to be loaded, then click on the [Open] button.
The measurement operator name file will be loaded, and alist of operator names will be displayed.

4 Thermo Collector _ O]

File Comm Edit ‘iew Help
£ &
3 B ] e
m‘ n Setup Persons - C:\Program Files\Thermo __. M=l E3 _

Mo. | Person | Hotes

1 tSmith rperature [ Lo Alarm [ Turn Alarm [«
2 |WWhite +060.0 On On

a

-End of procedure-
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4 Setting Up with the Personal Computer

m Other functions (Menu functions)
“Setup Tags/Logs’ submenu

New
Creates a new setup file of tags and logs.
open
Comm  Edit Yiew Help Opens a file in which tags and logs have

P Hew Ctl+N been stored.

Setup Persons 3 DOpen... Cirl+0

i
WEssured|[IatassF L/—Save . o .
: Save Chl+3 Overwrites a file in which tags and logs
Exit Save As.. _\have been set.
Mo. Mama Send —: Save As
1 |burger Brint..  ChkP Saves a file in which tags and logs have
been set under a new file name.
Send
Transmits the tag and log setup data to
the main unit.
Print
Outputs the tag and log setup data for
the printer.
“Setup Persons’ submenu
‘ Thermo Collector New
Comm Edit View Help Creates a new file for setting up operator names.
Setup Tags/Llogs * || | | 2 Open L .
0 Hew —/ Opens a file in which operator names have been stored.
easued [atas » Open... —_/— Save
Eit e _ Overwrites a file in which operator names have been set.
O T Saveps., ——  Save As
MO |1 ESmith | Class —] Saves a file in which operator names have been
1 |2 |white set under a new file name
2 | s w3 Close
3

Transmits the operator name data file currently
opened to the main unit.

Print
Outputs the operator name data for the printer.

4 L\ Closes the operator name setup screen.
Send

“Measured Datas” submenu

Save As
4 Themo Collector Saves the measurement data in a text format.
3N Comm Edit “iew Help
Setup Tags/Logs * [~ Close
Setup Persans g / Closes the measurement data file.

; Close Transfer
Exit _7_/_ Transfers the measurement data file to Excel.
Tranzfer.. —

Mo, : .
IEIERGER Print... —— Print
7 Prinl

Outputs the measurement data to the printer.

32
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“Comm” menu

hermo Collector Properties
m Edt View Set the conditions required to communicate with the personal

computer. Below are the setup items
« Communication port

« Baud rate

* Parity

« Data bits

« Stop bits

l Properties. ..
BReceive...

Receive
Receives from the main unit the measured temperature data and
other data set with the main unit.

“Edit” menu
Cut
W Moves the currently selected data to the pasteboard.
& YView Help

t Cut Cirl+= '_/— Copy

i Copy DHRC Copies the currently selected data to the pasteboard.

= Paste Chil+w
Delete  Del d Paste

Copies the data recorded in the pasteboard to the selected

location on the screen.

i

Select All Chil+d

Delete
Deletes the currently selected data.

Select All
Sets all the data on the currently selected box to the selected
condition.

[TIP]

Measurement data received from the main unit cannot be edited using the “ Edit” menu functions.

“Display” menu

Tool Bar

Switches on and off the toolbar display (button icon allowing
, v ToolBar - one-touch operation).

i ¥ StatusBar  4———— oiat s Bar

Switches on and off the status bar display (a region in which the
date and time are displayed).

“Help” menu
]

Ip

; Abaut Thermna Collectar... —[7 About Thermo Collector...

Displays the version information of the Thermo-Collector
software.

IM 54051-E
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4 Setting Up with the Personal Computer

m Other functions (Tool icons functions)
For efficiency, single-click on any of thetool iconsto instantly execute the assigned function.

|

34

Creates a new setup file of tags and logs.
This function is the same as “New” in the
“Setup Tags/Logs” submenu of the “File”
menu.

Loads afile of stored tags and logs. This
functionisthe sameas*“Open” inthe“ Setup
Tags/Logs” submenu of the “File” menu.

Saves the tag and log setup data file so it
overwrites the existing file. This function
is the same as “Save” in the “ Setup Tags/
Logs” submenu of the “File” menu.

Transmits the tag and log setup data cur-
rently selected to the main unit. Thisfunc-
tion is the same as “Send” in the “Setup
Tags/Logs’ submenu of the “File” menu.

Creates a new file for setting operator
names. Thisfunctionisthe sameas"New”
in the “Setup Persons” submenu of the
“File” menu.

L oads the operator name file that has been
saved. Thisfunctionisthe sameas*“Open”
in the “Setup Persons” submenu of the
“File” menu.

Savesthe operator namefilesoit overwrites
the existing file. This function isthe same
as“Save” in the “ Setup Persons” submenu
of the “File” menu.

Transmits the operator name data currently
displayed on the screen to the main unit.
This function is the same as “Send” in the
“Setup Persons” submenu of the “File”
menu.

3
Bl

Savesthemeasured datain atext format file.
This function is the same as “Save As” in
the“Measured Datas” submenu of the“File”
menu.

Transfers the measurement data which is
going to the personal computer to Microsoft
Excel. Thisfunctionisthesameas*“Trans-
fer” in the “Measured Datas” submenu of
the “File” menu.

Outputs the measurement data received in
association with the specified tag and log
to the printer. This function is the same as
“Print” in the “Measured Datas’ submenu
of the “Comm” menu.

Receives the data from the main unit. This
function is the same as “Receive” in the
“Comm” menu.

Moves the currently selected data to the
pasteboard. This function is the same as
“Cut” in the “Edit” menu.

Copies the currently selected data to the
pasteboard. This function is the same as
“Copy” in the “Edit” menu.

Copies the data recorded in the pasteboard
to the currently selected location on the
screen. Thisfunctionisthe sameas* Paste”
in the “Edit” menu.
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4 Setting Up with the Personal Computer

4.3 Setups required to use the collector function

(Setting the tag name, input channel, alarm, and operator
name)

Make tag settings before using the collector function.
m Setup contents

See Also
For information about each setup item, refer to “3.1 Setups required to use the collector function
(Setting the tag name, input channel, alarm, and operator name)”.

* Tag name

e Input channel

* Alarm

¢ Operator name

m Setting tags

1. initiate the “Thermo-Collector” software.
After the main screen of the “ Thermo-Collector” software has been displayed, the “ Setup Tags/Logs - New” screen
will appear.

’ Thermo Collector =] E3

File  Comm Edit iew Help
= || ] e T s I T

Setup TagsfLogs - New I

Tags |Logs |

Mo, Mame \ Channel | Hi Temperature | Hi Alarm | Lo Temperature | Lo Alarm | Turn Alarm | =

[ EGEE [3:03 PM p

2. Enter the tag name in the “Name” field with a maximum of eight alphanumeric charac-
ters (Example: Burger).

[TIP]

A piece of setup datawith an empty “Name” field cannot be transmitted to the main unit. Alwaysenter
aname for setup data to be transmitted.

IM 54051-E
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4 Setting Up with the Personal Computer

3.

36

Double-click in the “Channel” column.
The specified tag name is set and the pull-down menu will appear.

4 Thermo Collector | _ (O] |

File Comm Edit Wiew Help

AT

Setup Tags/Logs - C:\Program Files\Thermo Collector\COLLECTOR tmt

Tags |Logs |

Mo, MName \ Channel | Hi Temperature \ Hi Alarm | Lo Temperature | LoAlarm \ Turn Alarm |«
1 _|Burger
2

Select either A, C, or D.
The specified channel is set.

Click in the “Hi Temperature” column
The cursor moves to a cell for the “Hi Temperature”.

’ Thermo Collector =3

File Comm Edit “iew Help

o= = 11 ke o I e 1 el A
Setup Tagsflogs - C:\Program Files\Thermo CollectorA\COLLECTOR tmt

Tags |Logs |

MName \ Channel | Hi Temperature \ Hi Alarm | Lo Temperature | LoAlarm \ Turn Alarm |«
Burger

Enter the“Hi Temperature” with numeric characters (-999.9 to +999.9; Example: +091.0).

[TIP]

Enter a value that does not exceed “Hi temperature” of the probe used for actual measurement. The
“Hi Temperature” that can be measured varies according to the probe used for measurement.

The specified upper-limit temperature has been set.
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7. Double-click in the “Hi Alarm” column.
The pull-down menu will appear.

4 Thermo Collector
Fle Comm Edit Miew Help

1= 3

3 o L e ] e A [ [
Setup Tags/Logs - C:\Program Files\Thermo Collector\COLLECTOR.tmt

Tags | Lags |

MName | Channel | Hi Temperature \ Hi Alarm | Lo Ternperature | Lo Alarm | Turn Alarm |~

Burger A +091.0

8. Select either ON or OFF.

9. Click in the“Lo Temperature” column.

The upper-limit alarm ON/OFF setting is made and the cursor moves to the “Lo Temperature” column.

’ Thermo Collector M= E3

File: Comm Edit Miew Help

Tags | Logs |

Mame \Channel Hi Temperature | Hi Alarm | Lo Ternperature | Lo Alarm | Turn Alarm [«

Burger A +081.00 oM

10. Enter the “Lo Tem perature” with numeric characters (-999.9 to +999.9; Example: +021.0).

[TIP]

Enter avalue that does not fall below the “Lo Temperature” of the probe used for the actual measure-
ment. The"“Lo Temperature” that can be measured varies according to the probe used for the measure-

ment.

The specified lower-limit temperature has been set.

11. bouble-click in the “Lo Alarm” column.
The pull-down menu will appear.

’ Thermo Collector
Fle Comm Edit Miew Help

I[=] B3

et B
Hlzls] =2 XleE|
Setup Tags/Logs - C:\Program Files\Thermo Collector\COLLECTOR.tmt
Tags | Logs |

Mame | Channel [ HiTernperature | Hi Alarm [ Lo Temperature | Lo alarm [ Turn Alarm [«

Burger A +091.0 OM

IM 54051-E
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4 Setting Up with the Personal Computer

12. select either ON or OFF.

13.

4 Thermo Collector
File Comm Edit Wiew Help

The lower-limit alarm ON/OFF setting is made.

Click in the “Turn Alarm” column.
The pull-down menu will appear.

IS[=1 E3

|||

L@ H ) A 2 el 4 [
Setup Tags/Logs - C:\Program Files\Thermo CollectorA\COLLECTOR.tmt
Tags | Logs |

Mame
Burger

+091.0 On Or

14. select either ON or OFF.

38

’ Thermo Collector

The alarm condition is set.

\Channel HiTemperature | Hi Alarm | Lo Temperature LDAIarm\TurnAIarm -

IS[=] E3

File Comm Edit “iew Help

Setup Tags/Logs - C:\Program Files\Thermo Collector\COLLECTOR tmt

Tags |Logs |

MName
Burger

\ Channel | Hi Temperature \ Hi Alarm | Lo Temperature | Lo Alarm \ Turn Alarm | «

+041.0 on +021.0 on On

If multiple tags have to be set, select the “Name” field in the next line, then repeat steps 2 through 14.
Subsequently, set the operator name.

-End of procedure-
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m Setting the measurement operator name

hermo Collector

Ii[=1 E3

Comm  Edit Wiew Help
Setup Tags/Logs » I

PMImIrﬂl Elfﬂ%lg ._'El Xlﬂ"ﬂl

EasiEdDes Y Open [hermo Collector\COLLECTOR. tmt
Exit Save
GavEds.
Mo, MName sz nerature | HiAlarm | Lo Temperature | Lo Alarm | Turn Alarm |«
1 |BURGER +081.0 oM +021.0 Or oM
| Send
N Efirits:

1. select “New” from the * Setup Persons” submenu of the “File” menu.

A box for setting the Person name will appear.

’ Thermo Collector
File Comm Edit “iew Help

=1 E3

Lo Temperature | Lo Alarm | Turn Alarm | =

2. Inthe “Person” field, enter the operator name with a maximum of eight alphanumeric

characters (Example: Smith).

3. Click in the “Person” field on the next line.
The Persons name is set.

’ Thermo Collector M= E3

File Comm Edit “iew Help

1 e = ) A 1

I £ Setup Persons - Hew HE &3 _

FPerson | Motes

Srith

Lo Ternperature | Lo Alarm | Turn Alarm (=

If multiple Person names have to be set, select the next line and repeat steps 1 through 3.

-End of procedure-

IM 54051-E
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4 Setting Up with the Personal Computer

4.4 Setups required to use the logging function
(Setting the log name, input channel, measurement interval,
and measurement period)

Settings relating to the logging function must be made here.
m Setup contents

See Also
For more information about each setup item, refer to 3.2 Setups required to use thelogging function
(Setting the log name, input channel, measurement interval, and measurement period)”.

* Log name

e Input channel

* Measurement interval

* Measurement period

m Operation procedure
’ Thermo Collector H=] E3

File Comm Edit “iew Help

I E AT EY

Setup Tags/Logs - C:\Program Files\Thermo CollectorA\COLLECTOR.tmt

Tags | Logs |
Ma. Mame \ Channel | Hi Temperature \ Hi Alarm | Lo Ternperature | Lo Alarm \ Turn Alarm #

A +041.0 O +021.0 On On

1. Double-click on the * Logs” tab.
The log file setup screen will appear.

’ Thermo Collector =13

File Comme Edit Wiew Help

ond A = | s it I e A [

Setup Tags/Logs - C:\Program Files\Thermo Collector\COLLECTOR tmt

Tags Logs |

Mame \ Channel | Measuring Interval | Measuring Period

|

2. Inthe “Name” field, enter the tag name using a maximum of eight alphanumeric char-
acters (Example: Convey).
The specified log name s set

[TIP]

A piece of setup datawith an empty “Name” field cannot be transmitted to the main unit. Alwaysenter
aname for setup data to be transmitted.

IM 54051-E
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3. Double-click in the “Channel” column.
The pull-down menu will appear.

’ Thermo Collector =] E3

File Comm Edit Wiew Help
=] = X

Setup Tags/Logs - C:\Program Filez\Thermo Collector\COLLECTOR.tmt

Tags Logs |
Mo, MName \ Channel | Measuring Interval | Measuring Period
1_[Convey

4. select either A, C, or D.
The specified channel is set.

5. Clickin the “Measuring interval” column.
The cursor moves to a cell for the measurement interval.

’ Thermo Collector =] 3

File Comm Edit Wiew Help
Ne |8 o ] e ) 1=

Setup Tags/Logs - C:\Program Files\Thermo Collector\COLLECTOR.tmt

Tags Logs |

MName \ Channel | Measuring Interval | Measuring Period
Convey A

6. Enter the measurement interval with numeric characters and colons “:” (Example:
00:10:00).

[TIP]

Use numeric characters and colons to enter a measurement interval. Theinput rangeis: hh < 25, mm
< 60, and ss < 60, where “hh” denotes hours, “mm” denotes minutes, and “ss” denotes seconds.

All theinterval datamust be eight charactersor less(i.e. “hh:mm:ss’. h, m, and s are optional numeric
characters).

The specified measurement interval has been set.

IM 54051-E
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4 Setting Up with the Personal Computer

7.

42

Click in the “Measuring period” column.
The cursor moves to a“Measuring period” field.

’ Thermo Collector =] E3
File Comm Edit “iew Help

1 i B i =) e A 1 [
Setup Tags/Logs - C:\Program Files\Thermo Collector\COLLECTOR.tmt

Tags Logs |

Mame \ Channel | Measuring Interval | Measuring Period
Corvey A ]

Enter the measurement period with numeric characters, a backslash, and colons
(Example: 003/20:30:00).

[TIP]

Use numeric characters, a backslash, and colons to enter a measurement period. The input range is:
ddd < 1000, hh < 24, mm < 60, and ss < 60, where “ddd” denotes the number of days, “hh” denotes
hours, “mm” denotes minutes, and “ss’ denotes seconds.

All the period data must be twelve characters or less (i.e. “ddd:hh:mm:ss”. d, h, m, and s are optional
numeric characters).

The specified measurement period has been set.
If multiple tags have to be set, select a“Name” cell from the next line, then repeat steps 2 through 8.

-End of procedure-
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4.5 Transmitting the setup data to the main unit

If the setup operation for the personal computer has been completed, transmit the setup data
of the tag, log, and operator name to the main unit.

Tag setup data and log setup datawill be transmitted in abatch and as onefile. The operator
datawill be transmitted separately.

A\ NOTE

If the setup data is transmitted to the main unit, the setup data and measurement data
that existed in the main unit before transmission will be deleted.

m Preparation for transmission
1. confirm that the power to the personal computer and main unit is OFF.

2. Connect the personal computer and main unit with the supplied cable.

See Also

For information about connecting the personal computer and main unit, refer to “m Connecting the
personal computer and main unit” in section 4.1.

3. Turn on the power of the main unit.

See Also

For information about turning on the power to the main unit, refer to “4 Turn ON/OFF of the Power
Supply” in the “Information Required before Use” part.

4. Turn on the power of the personal computer.
Now it isready for transmission.

-End of procedure-
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4 Setting Up with the Personal Computer

m Transmitting the tag and log setup data to the personal computer

1. initiate Thermo-Collector software.
After the main screen of Thermo-Collector software has been displayed, the “ Setup Tags/Logs - New” screen will be
displayed.

’ Thermo Collector =3

File Comm Edit Yiew Help
NeER oA e s 4

Setup TagsfLogs - New

Tags |Logs |

Mo, Mame \ Channel | Hi Temperature \ Hi Alarm | Lo Temperature | Lo Alarm \ Turn Alarm | «

\ [118/99 [3:03 PM P

2. Load afile in which the tag and log setup data is stored.

See Also

For information about loading afile containing tag and log data, refer to “m Loading afile containing
the setup data” in section 4.2.

Comm Edit Yiew Help
5 H Hew Cirl+h
Setup Persons b Open... Chl+0
Ieasired Vatass F s Chies
Exit Save Az,

Chl+P

Mo, MName \
1.0 on +021.0 on On

Lre\HiAIarm Lo Temperature | Lo Alarm | Turn Alarm | «
1 _|Burger

3. Select“Send” in the ® Setup Tags/Logs” submenu accessed from the “File” menu.
The confirmation dialog box will appear.

Thermo Collector E

@ “fiou are going to send the content as below;
Tage:Mo.1-1/Logs:Ma 1-1

Cancel |

IM 54051-E
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4. click on the [OK] button.
A dialog box indicating the progress of data transmission will be displayed. At the same time, “Sending...” is
displayed on the main unit.

Communication

Sending...

After the transmission of the tag and log setup data has been completed, the screen indicating the progress of data
transmission and the screen displaying the “Comm...” message on the main unit will disappear.

-End of procedure-
m Transmitting the measurement operator name data

1. Load afile in which the operator name to be transmitted is stored.
4 Thermo Collector | _[Of |

File Comm Edit Miew Help
|| B2 e e v A [ =
] Setup Persons - C:\Program Files\Thermo . [[E E3 | LECTOR tmt
Mo [ Person | Nates
1 Sm\th Lo Temperature \ Lo Alarm | Tum Alarm |«
L2 |White +021.0  ON oN
3
e
LS
6|
7
& |
L&
10
[7a =
I [1/18/29 [234 PM 7
See Also

For information about loading afile containing operator names, refer to “m Loading afile containing
the setup data” in section 4.2.

2. Select “Send” in the “Setup Persons” menu accessed from the “File” menu.
A dialog box indicating the progress of transmission will be displayed.
At the same time, “Comm...” is displayed on the main unit.

Communication

Sending...

After the transmission of the operator data has been completed, the screen indicating the progress of data transmis-
sion and the screen displaying the “ Comm...” message on the main unit will disappear.

-End of procedure-
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5 Confirm, Modify, Clear, or Delete the Data with the Main Unit

5 Confirm, Modify, Clear, or Delete the Data with the Main Unit

5.1 Confirming the number of

pieces of tag data

This section explains the procedure for con-
firming the number of pieces of tag data.

46

Home screen

a
INPUT v

| 18:54:27
25.9°C

. Press the [FUNC], [1], and [1] keys, in

this order.
The “Curr tag” screen appears on the LCD.

a
INPUT v

| F11
Curr Tag

Press the [SET] key.

\INPUT v

. Burger

12

Press the [ ¥] key repeatedly until the tag to
be confirmed is displayed on the screen.
The tag name and the measurement data recorded in
association with the tag will be displayed.

a
INPUT v

| Beef

5

Pressthe [ESC] key repeatedly to return to the Home
screen.

-End of procedure-

5.2 Modifying the tag name

This section explainsthe procedure for modi-
fying the tag name.

Home screen

A
INPUT v

| 18:54:27
25.9°C

. Press the [FUNC], [1], and [2] keys, in

this order.
The “TagChnge” screen appears on the LCD.

a
INPUT v

| F12
TagChnge

. Press the [SET] key.

\INPUT v

i, Burger

12

. Press the [ ¥] key repeatedly until the

tag to be modified is displayed on the
screen.

INPUT

" Beef

5

. Use the [CH] key to select the input

channel.
Theinput channel of the [INPUT] gage is modified.
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5. Press the [SET] key.

INPUT )
| Beef

5

. Enter a new tag name to be modified.
INPUT ( )
1

! Pork

[TIP]

A tag name that has not been modified will be
displayed. If it needsto be modified, overwrite
it with anew tag name.

See Also

For information about entering a character or
number, refer to “6 How to Input Characters”
inthe* Information Required before Use” part.

7. Press the [SET] key.

The confirmation dialog box will appear.

INPUT

| Change?

Yes1/NoO

8. Press the [1] key.

The tag name after modification will be displayed.

a
INPUT v

| Pork
5

The tag name has been modified.
Pressthe [ESC] key repeatedly to return to the Home
screen.

-End of procedure-

. Press the [SET] key.

. Press the [SET] key.

5.3 Clearing the measurement

data associated with the tag

This section explains the procedure used to
clear the measurement data obtained with the
collector function. However, the setup data
(tag name) will not be cleared.

Home screen

a
INPUT v

| 18:54:27
25.9°C

. Press the [FUNC], [4], and [1] keys, in

this order.
The “1TagFile” screen appears on the LCD.

a
INPUT v

| F41
1TagFile

b v

. Burger

12

. Press the [ ¥] key repeatedly until a tag

with measurement data that is to be
cleared is displayed on the screen.

a
INPUT v
I. Chicken

217

The confirmation dialog box will appear.

INPUT

| TagClr?
Yes1/NoO

IM 54051-E
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5 Confirm, Modify, Clear, or Delete the Data with the Main Unit

5. Press the [1] key. 1. Press the [FUNC], [1], and [4] keys, in
a this order.
wer v The “Tag Del” screen appears on the LCD.
I Chicken :

0 | F14
Tag Del

All the measurement data of the selected tag will be
cleared.

Pressthe [ESC] key repeatedly to return to the Home
screen. 2

Press the [SET] key.

-End of procedure-

9.4 Deleting the ta v
: J i, Burger

12

This section explains the procedure used to
delete the tag from the main unit.

ﬂ Note

3. Press the [ v] key repeatedly until the
- tag to be deleted is displayed on the
Before deleting the tag, save the mea- sc%een s display
surement data associated with the tag :
to a personal computer, etc. oo ¢
Once the tag has been deleted, all the i H
measurement data associated with the lLc Ch ICken
tag will be completely lost. 0
See Also 4. Press the [SET] key.
For information about the procedure used to The confirmation dialog box will appear.
savethe measurement data, refer to“1 Receiv-
ing the Data on the Personal Computer” in the .
“Utilizing the Measurement Data” part. !
? P | Delete?
Home screen Ye S 1/N O 0
a
r&PUT '
I_C 18:54:27 5. Press the [1] key.

25.9°C

The selected tag and its associated measurement data
will be deleted.

Pressthe [ESC] key repeatedly to return to the Home
screen.

-End of procedure-
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5.5 Confirming the log setup
data

This section explains the procedure used to
confirm the log setup data.

Home screen

| 18:54:27

25.9°C

1. Press the [FUNC], [2], and [1] keys, in
this order.
The “Curr Log” screen appears on the LCD.

a
INPUT v

| F21
Curr Log

2. Press the [SET] key.

\INPL/T v

i, Convey

12

3. Press the [ v] key repeatedly until the
log to be confirmed is displayed on the

screen.
INPUT %
. Accep

4. press the [SET] key.
The current interval will be displayed.

INPUT

i Interval

00:00:10

5. Press the [SET] key.
The current period (the number of days selected from
the options, including al so the number of hours, min-
utes, and seconds) will be displayed.

INPUT

| ProdDay
2

6. Press the [SET] key.
The current period (the number of hours, minutes,
and seconds from the optionsincluding also the num-
ber of days) will be displayed.

INPUT

| ProdTime

00:00:30

[TIP]

If the [SET] key is pressed, the screen used to
confirm the interval set in step 4 isrestored.

Pressthe [ESC] key repeatedly to return to the Home
screen.

-End of procedure-
5.6 Modifying the log name

and setup data (measure-
ment interval and period)

This section explains the procedure used to
modify the log name, measurement interval,
and measurement period.

Home screen

| 18:54:27

25.9°C
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5 Confirm, Modify, Clear, or Delete the Data with the Main Unit

1.

50

Press the [FUNC], [2], and [2] keys, in
this order.
The “LogChnge” screen appears on the LCD.

a
INPUT v

| F22
LogChnge

Press the [SET] key.
A screen for selecting alog will be displayed.

INPUT v

. Convey

12

Press the [ ¥] key repeatedly until the
log to be modified is displayed on the
screen.

a
INPUT v
AcCC ep

0

Use the [CH] key to select the input
channel.
The input channel of the [INPUT] gage is modified.

Press the [SET] key.
A screen for modifying the log name will be dis-
played.

INPUT >
i, Accept

0

6. Enter anew log name to be modified.

INPUT < >
. Carry

0
[TIP]

¢ A log name can consist of a maximum of
eight alphanumeric characters.

« A tag name that has not been modified is
displayed on the screen. If it needs to be
modified, overwriteit with anew tag name.

See Also

For information about entering a character or
number, refer to “6 How to Input Characters’
inthe" Information Required before Use” part.

7. Press the [SET] key.

A screen for modifying the measurement interval will
appear.

INPUT >
. Interval

00:00:10

Enter the hours, minutes, and seconds.
INPUT <

1

. Interval

00:00:30

[TIP]

The definition and range of each input valueis
given below.

00:00:00

Indicates the seconds.

The input range is between 0
and 59 seconds

Indicates the minutes.

The input range is between 0
and 59 minutes

Indicates the hours.

The input range is between 0
and 24 hours.
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5 Confirm, Modify, Clear, or Delete the Data with the Main Unit

9. Press the [SET] key. 13. Press the [SET] key.
The measurement interva is modified and a screen for The confirmation dialog box will appear.
modifying the measurement period (the number of days
from the options, which also includes the number of e
hours, minutes, and seconds) will be displayed. 1
; . Change?
INPUT
1
|, ProdDay Yes1/NoO
O 0 0 14. press the [1] key.
The measurement period has been set.
10. Enter the number of days. a
[TIP] y
: i, Carry
Between 0 and 999 days can be inputted. 0
11 Press the [SET] key. . Pressthe [ESC] key repeatedly to return to the Home
A screen for modifying the measurement period (the screen
number of hours, minutes, and seconds from the op- '
ggr:j?a\)/\(g/c;z also includes the number of days) will -End of procedure-
\INPL/T )
| ProdTime
12. Enter the number of hours, minutes, and
seconds.
rJPUT < .
. ProdTime
[TIP]
The definition and range of each input valueis
given below.
00:00:00
Indicates the seconds.
The input range is between 0
and 59 seconds
Indicates the minutes.
The input range is between 0
and 59 minutes
Indicates the hours.
The input range is between 0
and 23 hours.
IM 54051-E
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5 Confirm, Modify, Clear, or Delete the Data with the Main Unit

5.7 Clearing the measurement
data associated with the log

Thissection explainsthe procedurefor clear-
ing the measurement data obtained with the
logging function. However, the setup data
(log name, measurement interval, and mea-
surement period) will not be cleared.

Home screen

a
INPUT v

| 18:54:27
25.9°C

1. Press the [FUNC], [4], and [2] keys, in
this order.
The “1LogFile” screen appears on the LCD.

a
INPUT v

| F42
1LogFile

2. Press the [SET] key.

INPUT v

. Convey

12

3. Press the [ v] key repeatedly until alog
with measurement data that is to be
cleared is displayed on the screen.

a
INPUT v

| Accep

3

4. Press the [SET] key.
The confirmation dialog box will appear.

INPUT

! LogClIr?
Yes1l/NoO

5. Press the [1] key.

a
INPUT v

| Accep

0

All the measurement data of the selected log will be
cleared.

Pressthe [ESC] key repeatedly to return to the Home
screen.

-End of procedure-

5.8 Deleting the log

This section explains the procedure used to
delete the log from the main unit.

A@A Note

Before deleting the log, save the mea-
surement data associated with the log
to a personal computer, etc.

If the log has already been deleted, all
the measurement data associated with
the log will be completely lost.

See Also

For information about the procedure used to
save the measurement data, refer to“1 Receiv-
ing the Data on the Personal Computer” in the
“Utilizing the Measurement Data” part.

Home screen

a
INPUT v

| 18:54:27
25.9°C
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5 Confirm, Modify, Clear, or Delete the Data with the Main Unit

1. Fhr_ess ghe [FUNC], [2], and [4] keys, in 59 Batch_c|earing the mea-
The“Log D" screen sppesrs o the L.CD. surement data associated
with both the tag and log

a
INPUT v
i F24 This section explains the procedure used to
Le clear all the measurement data associated
|_ 0 g D el with both the tag and log. However, note
that the setup datawill not be cleared.
2. Press the [SET] key. Home screen
‘.NPUT v INPUT e
L, Convey | 18:54:27
12 25.9°C

3. Press the [v] key repeatedly until the 1. Press the [FUNC], [4], and [4] keys, in

log to be deleted is displayed on the this order.
screen. The“All File” screen appears on the LCD.
INPUT e ‘
i A !\JPUT v
L, Accep | F44
0 All File
4. Press the [SET] key. 2. Press the [SET] key.

The confirmation dialog box will appear.

INPUT

o i 2

Yes1/NoO Yes1/NoO

3. Press the [1] key.

5. Press the [1] key. . All the measurement data recorded in the main unit
The selected log and its associ ated measurement data will be cleared.
will be deleted. Pressthe [ESC] key repeatedly to return to the Home
Pressthe [ESC] key repeatedly to return to the Home screen.
screen.

-End of procedure-
-End of procedure-
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5 Confirm, Modify, Clear, or Delete the Data with the Main Unit

5.10Initializing the main unit

This section explains the procedure used to
initialize the main unit.

ﬂ Note

Before initializing the main unit, it is rec-
ommended to save the setup data and
measurement data in the main unit to a
personal computer, etc.

When the main unit is initialized, all the
setup data and measurement data re-
corded in the main unit will be lost. How-
ever, the instrument name, chime setup,
and time setup data will not be erased.

See Also

For information about the procedure used to
save the measurement data, refer to“1 Receiv-
ing the Data on the Personal Computer” in the
“Utilizing the Measurement Data” part.

Home screen

a
INPUT v

| 18:54:27
25.9°C

1. Press the [FUNC], [0], and [1] keys, in
this order.
The “Initial” screen appears on the LCD.

a
INPUT v

| FO1
Initial

2. Press the [SET] key.

INPUT

I Initial?

Yes1/NoO

3. Press the [1] key.
Theinitialization process begins.

INPUT

lLInitia--

In two minutes, all the data set in the main unit will be
erased and the “Initial” screen will be restored,
Pressthe [ESC] key repeatedly to return to the Home
screen.

-End of procedure-

5.11 Confirming the current op-
erator name

This section explains the procedure used to
confirm the operator name currently set.

Home screen

a
INPUT v

| 18:54:27
25.9°C

1. Press the [FUNC], [8], and [1] keys, in
this order.
The “CurrData” screen appears on the LCD.

a
INPUT v

| F81
CurrData

2. Press the [SET] key.
The operator name currently set will be displayed.

a
ot v

l.c 1
Smith

Pressthe [ESC] key repeatedly to return to the Home
screen.

-End of procedure-
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5 Confirm, Modify, Clear, or Delete the Data with the Main Unit

5.12 Modifying the operator

This section explains the procedure used to

switch the currently set operator.

Home screen

a
INPUT v

| 18:54:27
25.9°C

Press the [FUNC], [8], and [2] keys, in
this order.
The “Change” screen appears on the LCD.

a
INPUT v

|, F82
Change

Press the [SET] key.
A screen for modifying the operator will be displayed.

a
et v

B 1
Smith

Press the [ ¥] key repeatedly until the
operator to be modified is displayed on
the screen.

Operator names assigned to numbers between 1 and
10 will be sequentially displayed.

a
ot v

3 2
White

Press the [SET] key.
The operator set on the main unit will be changed.

Pressthe [ESC] key repeatedly to return to the Home
screen.

-End of procedure-
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1 Input Channel and Probe

1 Input Channel and Probe

When measuring temperatures with Thermo-Collector, it is necessary to use an
appropriate input channel and probe. By combining theseitems in different ways,
it is possible to measure the temperature of various objects. The temperature of
air (gases), the surface and center of a solid, and various types of liquids can be
measured.

For example, the “C” input channel (built-in sensor of the main unit) is used to
measure the ambient air temperature. To measure the temperature at the center
of ahamburger, connect a needle-type standard probe to the“A” measuring chan-
nel. To measure the surface temperature of a steel plate, connect a radiation
temperature probe to the “D” input channel.

The following table shows the available probe types, their corresponding input
channels, and the positions of connection jacks.

Probe (option) type Input channel Position of connection jack

Standard needle probe (Model name: 900 01)

High speed needle probe (Modd! name: 500 11) A Left Sde of thetop face (position marked *A” on the cover)
Surface probe (Model name: 900 12)

Rounded end probe (Model name: 900 13)

Built-in sensor C Built into the main unit

Emission thermo probe (Model name: 900 03)

O

Left Sdeof thebottom face (position marked“D” onthecover)

A Warning

Do not point the tip of a needle-type standard probe or needle-type high-speed probe
towards somebody. The needle tip is very sharp and can cause injury.

A Caution

« Handle the needle-type standard probe and needle-type high-speed probe carefully
so that its stylus is only put into the intended measuring object.

« Do not use this instrument in a location where it may be splashed or dropped in
water, otherwise it may malfunction.

IM 54051-E
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1 Input Channel and Probe

Needle-type standard probe

An example of the needle-type standard probe connected to input channel “A”

A Note

Only connect a probe to input channel “A” if the power to the main unit is off or if the
home screen is being displayed. If the probe is connected to the channel after a tag
has been selected, this instrument may start having datalogged into it the moment the
connection is made.

Built-in sensor

Position of input channel “C”  An example of the radiation temperature probe connected to input channel “D”

IM 54051-E
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2 Measuring Temperatures with the Collector Function

2 Measuring Temperatures with the Collector Function

This section explains the procedure for measuring temperatures with the collector function.

58

Home screen

“ 18:54:27
25.9°C
[TIP]

. This screen which indicates the current
time is referred to as the “Home” screen.
Each function in the main unit is accessed
from this screen.

¢ The[O] key isalso used for switching the
unit of temperaturedisplay. If, for example,
this[0] key is pressed in the Home screen,
the unit is switched to “°F”. Another press-
ing of the same key will restore the unit to
“eCr.

Press the [LOGGING] key when the[Kelg
mark is displayed in the upper left cor-
ner of the screen.

The mark is turned off and the
collector mode is entered.

If the “A” or “D” input channel is to be
used, connect the probe to the appro-
priate jack.

MNOTE

Only connect a probe to input channel
“A” if the Home screen is on. If the
probeis connected to the channel after
atag has been selected, this instrument
may start having data logged into it the
moment the connection is made.

See Also

For information about connecting an input
channel to a probe, refer to “1 Input Channel
and Probe”.

3. Press the [ v] key repeatedly until the

tag to be selected is displayed on the
screen.
The tag name currently set will be displayed.

\INPUT <'>
i, Burger

24°C

If the operator name needs to be modi-
fied, press the [1] numeric key. If not,
proceed to step 7.

[TIP]

If the operator name is not modified at this point,
the operator name assigned the registration number
“1” will automatically be set. Therefore, the factory-
setting operator name must be modified if an op-
erator other than that which is assigned the registra-
tion number “1" performs the measurement task.

A
v

INPUT
]

" 1
Smith

A screen for modifying the operator namewill bedis-
played.

Press the [ ¥] key repeatedly until the
operator name to be selected is dis-
played on the screen.

A
et v

I.c 2
White
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2 Measuring Temperatures with the Collector Function

Press the [SET] key.
The confirmation screen will appear.

INPUT

i Change?

Yes1/NoO

Press the [1] key.
The operator name is modified and the previous
screen displaying the tag name is restored.

)
i. Burger

24°C

Press the [MEMORY] key.

A &] mark is displayed in the measurement screen,
and the measurement is terminated as soon as the
buzzer sounds. The measured value will be stored in
memory together with the current time.

\INPL/T <'>
. Burger

" 24°C

The I’i'l mark will be turned off after the measure-
ment has been completed.

[TIP]

¢ |If the [MEMORY] key is pressed when
[NewTag] isbeing displayed, anew tag will
automatically be created. New tags will
automatically be assigned tag names such
as TAGO1 and TAGO2.

« If the measurement continues with the se-
lected tag, perform step 7 again after step 8
has been performed. With 50 tags, a total
of 5,000 pieces of data can be recorded.

Pressthe [ESC] key repeatedly to return to the Home
screen.

-End of procedure-
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3 Measuring Temperatures with the Logging Function

3 Measuring Temperatures with the Logging Function

If alog has measured data remaining in it, it is not possible to record new mea-
surement data additionally on the same log. To record new data in the log, it must
be cleared beforehand.

[TIP]

The[0] key is also used for switching the unit
of temperature display. If, for example, this
[O] key is pressed in the Home screen, the unit
is switched to “°F”. Another pressing of the
same key will restore the unit to “°C”.

See Also

For information about clearing the measured
datain alog, refer to “5.7 Clearing the mea-
surement data associated with the log” in the
“Preparation for Measurement” part.

Home screen

a
INPUT v

| 18:54:27
25.9°C

Press the [LOGGING] key when the
mark is not displayed in the upper left
corner of the screen.

The mark is turned on and the logging mode
is entered.

LOG a
INPUT v

| 18:54:42
25.9°C

If the “A” or “D” input channel is to be
used, connect the probe to the appro-
priate jack.

ﬂ Note

Only connect a probe to input channel
“A” if the Home screen is on. If the
probeis connected to the channel after
atag has been selected, this instrument
may start having data logged into it the
moment the connection is made.

See Also

For information about connecting an input
channel and aprobe, refer to“1 Input Channel
and Probe”.

Press the [ ¥] key repeatedly until the
log to be selected is displayed on the
screen.

The log name currently set will be displayed.

LOG a
INPUT v

| Carry
24°C
Press the [MEMORY] key.

The interval at which the temperature measurement
is performed will be displayed.

LOG

INPUT

i Interval

00:00:10
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3 Measuring Temperatures with the Logging Function

5. Press the [MEMORY] key again.

Measurement begins. During measurement the ]
mark is displayed in the lower left corner of the
screen.

LOG
INPUT

| 00:00:07
& 24°C

[TIP]

¢ During measurement the number of days
or time elapsed can be confirmed with the
[ A] key or [ ¥] key.

¢ |If the [MEMORY] key is pressed when
[NewTag] is being displayed, a new tag
will automatically be created. New tags
will automatically be assigned tag names
such as TAGO1 and TAGO2.

« To stop the measurement, hold down
the [ESC] key for about two seconds.

If the measurement has been compl eted, the previ-
ous screen displaying thelog name will be restored.

LOG a
INPUT v

i Carry
24°C

Pressthe[ESC] key repeatedly to return to the Home
screen.

-End of procedure-
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4 Measuring Temperatures with the Radiation Temperature Probe

4 Measuring Temperatures with the Radiation Temperature Probe

The measurement accuracy of the radiation temperature probe(Model name:900
03) is not reliable below the decimal point. Therefore, before making a tempera-
ture measurement with the radiation temperature probe, set this instrument so
that it does not display a fraction of a temperature in the screen of the main unit.
The radiation temperature probe, however, can be used with this instrument to
measure temperatures without performing the following setups, but, if this is done,
the accuracy of the decimal in the temperature measurement cannot be guaran-

teed.

m Switching on/off the decimal
portion of the temperature display

Home screen

a
INPUT v

| 18:54:27
25.0°C

1. Press the [FUNC], [9], and [3] keys, in
this order.
The “Digit” screen will appear on the LCD.

a
INPUT v

| F93
Digit
2. Press the [SET] key.

A screen for switching on/off the decimal portion of
the temperature display will be displayed.

a
INPUT v

| Digit
0.1°C

3. Press the [ v] key.
The decimal portion of the display will be turned off.

a
INPUT v

| Digit
1°C

[TIP]

Each timethe[ ¥] key is pressed, the decimal
portion of the temperature is toggled on/off.

4. Ppress the [SET] key.
Thedecimal portion of the temperaturewill no longer
be displayed.

a
v

INPUT

| F93
Digit

5. Pressthe [ESC] key three times.
Thetimedisplay screen (i.e. Home screen) isrestored.

a
INPUT v

| 18:54:57
25°C

-End of procedure-
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m Measuring with the radiation temperature probe

1.

A\ Warning

Do not look into the laser beam which is emitted from the radiation temperature probe.
The laser can cause eye damage and other injuries.

A Note

Before using the radiation temperature probe, read the instruction manual supplied
with the radiation temperature probe.

Connect the “D” channel jack on the main unit and the radiation temperature probe.
[TIP]

« Insert the connector plug so that the “ <" mark on the cable grip faces upward.
¢ The“D” channel connection jack is located on the left side of the main unit bottom face.

Measuring in the collector mode

2. Set the main unit to the collector mode, then select a tag and operator name for the
measurement.
See Also
For more information about the collector mode, refer to “2 Measuring Temperatures with the Collec-
tor Function”.
3. Turn the radiation temperature probe towards the measuring object, and press the
[MEASURE] key.
A laser beam will be emitted from the radiation temperature probe and onto the measuring object.
[TIP]
If the laser beam is not being emitted, press the [POINTER] key on the radiation temperature probe.
4. while holding down the [MEASURE] key, press the [MEMORY] key on the main unit.
The temperature being displayed on the radiation temperature probe screen will also be displayed on the screen of
the main unit. When the buzzer sounds on the main unit, the measured value and current time will be stored in
memory.
[TIP]
If the measurement continues with the selected tag, perform step 3 again after step 4 has been per-
formed.
-End of procedure-
IM 54051-E
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4 Measuring Temperatures with the Radiation Temperature Probe

Measuring in the logging mode

2.

64

Set the main unit to the logging mode, then select a log for the measurement.

See Also

For more information about the logging mode, refer to “3 Measuring Temperatures with the Logging
Function”.

While holding down the [MEASURE] key, turn the radiation temperature probe towards
the measuring object.
A laser beam will be emitted from the radiation temperature probe and onto the measuring object.

[TIP]
If the laser beam is not being emitted, press the [POINTER] key of the radiation temperature probe.

Press the [MEMORY] key twice.
Measurement begins.

[TIP]

To stop the measurement, hold down the [ESC] key for about two seconds.

After the specified measurement period elapses, the previous screen displaying the log name will be restored.

Hold down the [MEASURE] key on the radiation temperature probe until the measure-
ment has been completed.

-End of procedure-
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5 Other Useful Functions

5 oOther Useful Functions

m To instantly clear the measured data on the main unit
There is afunction on the main unit to clear the recorded measurement data.
If the measured data recorded in the main unit is not required anymore or if it needs to be
cleared instantly, use this function.
1. Bring up the Home screen.
2. Press the [ v] key repeatedly until the tag to be deleted is displayed.
3. Use either the [<] or [>] key to select the measured data to be deleted.
[TIP]
Press the [<] key once to bring the last piece of measured data recorded for the tag up on the screen.
The measured data is displayed.
4. Press the [FUNC] key.
The confirmation screen will appear.
5. Press the [1] key.
The measured data will be cleared.
[TIP]
If the [FUNC] key is pressed while the tag name display screen is active, al the data associated with
the currently selected tag will be cleared (this function can also be applied to logs).
-End of procedure-
m To start a measurement in the logging mode at a specified time
(timer function)
The main unit has a function (timer function) to start logging measurement at a specified
time. Thisisuseful to, for example, start |ogging measurements after one hour.
[TIP]
If the selected log has measurement data remaining in it, thistimer function cannot be used. If thisis
the case, either clear the measured data from the log or select another log.
See Also
For information about clearing the measured datain alog, refer to “5.7 Clearing the measurement data
associated with the log” in the “Preparation for Measurement” part.
1. Bring up the Home screen.
2. Press the [FUNC], [2], and [5] keys, in this order.
The “Timer reserve” screen will appear.
3. Press the [SET] key.
4. Press the [ v] key repeatedly until the log to record temperatures are displayed.
5. Press the [SET] key.
The measurement interval set for the selected log will be displayed.
IM 54051-E
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5 Other Useful Functions

6.

10.
11.

66

Press the [SET] key.
[TIP]
It is also possible to modify the measurement interval setting before pressing the [SET] key.

Press the [SET] key.
The measurement period (the number of days from the options which also include the number of hours, minutes, and
seconds) will be displayed.

[TIP]
It is also possible to modify the number of days setting before pressing the [SET] key.

Press the [SET] key.
The measurement period (the number of hours, minutes, and seconds from the options which also includes the
number of days) will be displayed.

[TIP]

It is also possible to modify the number of hours, minutes, and seconds settings before pressing the
[SET] key.

Set the date (year/month/day) and time when logging starts.

Press the [SET] key.
The confirmation screen will appear.

Press the [1] key.

The @ mark and“ Stand by” will be displayed in the screen, and the instrument will enter the wait state. When the
time set in step 9 is reached, the measurement will automatically begin.

a
INPUT ® v

| 21:30:20
Stand by

[TIP]
To cancel the wait state, hold down the [ESC] key for about two seconds.

-End of procedure-
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5 Other Useful Functions

m To quickly search for a tag or log
The main unit has a function to search for atag or log using a number as the key.
This function is useful if there are many logs and tags set in the main unit and is faster than
using the[ v] key.
1. Bring up the Home screen.
2. Press the [ v] key.
3. Press the [POWER] key.
4. Enter a two-digit number.
[TIP]
A two-digit number entered is displayed in the “No.” field of Thermo-Collector screen. It isrecom-
mended to make a note of which tag or log corresponds to which number.
5. Press the [SET] key.
The tag (or log) that corresponds to the entered number will be displayed on the screen.
-End of procedure-
m To record measured data if the tag or log has not been set
In addition to the function for creating atag or log from the Function menu, the main unit has
a useful way to create them during measurement.
Thisisvery useful when, for example, the temperature of a steel plate needs to be measured,
but atag for that steel plate has not been set beforehand.
1. Bring up the Home screen.
2. Press the [ v] key repeatedly until [NewTag] or [NewLog] appears on the screen.
[NewTag] or [NewLog] will appear on the screen.
3. Press the [MEMORY] key.
The temperature will be measured.
[TIP]
Tags (or logs) will be temporally assigned a specific name using sequential numbers (Examples: Tag01,
Tag02, Log01, Log02....). Inthis case, the measurement interval for thelog is automatically set to 10
seconds, and the measurement period of the log is set to 2 days. However, these temporary tag names
and log names can be modified later as required.
See Also
For information about modifying tag or log names, refer to “5 Confirm, Modify, Clear, or Delete the
Datawith the Main Unit” in the “Preparation for Measurement” part.
-End of procedure-
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5 Other Useful Functions

m Torecord the start time and finish time of an operation (only with the
collector function)

The main unit has afunction to record the start time and finish time of measurement opera-
tion.

Thisis useful when, for example, creating a daily report, since the start time and finish time
can beincluded in Microsoft Excel files or printouts.

e Recording the start time
1. Press the [ v] key repeatedly until the tag to record temperatures is displayed.

2. Press the [2] key.
The confirmation screen will appear.

3. Press the [1] key.
The start time will be recorded.

-End of procedure-
e Recording the finish time

1. Press the [3] key if selecting a tag.
The confirmation screen will appear.

2. Press the [1] key.
The finish time will be recorded.

-End of procedure-

m To restrict inputs from the panel keys (the key lock function)
The main unit has afunction called the key lock function that disables dl the panel keysfor input.

Thisfunction isused if the main unit is used only for temperature measurement and atemperature
record does not need to be retained, or when the main unit is used as a clock.

This function can be set by pressing the [FUNC], [9], and [5] keys in this order and in the Home
screen.

While this function is active, the “Key” mark will be displayed in the upper right corner of the
screen.

[TIP]

In order to cancel this function, hold down the [ESC] key for about two seconds.
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5 Other Useful Functions

m To enable only the panel keys (yellow keys) requied for mesurement
(FUNC lock function)
The main unit has afunction called the FUNC lock function that enables only the panel keys
reguired for measurement. The keys used with this function are given below :
* [MEMORY]
e [v]and[a]
* [CH]
* [LOGGING]
* [POWER]
* [ESC]
* [SET]
* [>],[<], [1], [2], [3], and [O] (only if the collector function is on)
This function can also be used when the setup information on the main unit is not to be
modified due to an operation error.
This function can be set by pressing the [FUNC], [9], and [6] keys, in this order and in the
Home screen.
When thisfunctionisactive, the“Key” mark will be displayed in the upper right corner of the
screen.

[TIP]
To cancel this function, hold down the [ESC] key for about two seconds.

m To automatically turn off the power supply if no operation is performed
in a specified period of time (Auto Power Off function)
The main unit has afunction called Auto Power Off to automatically turn off the power if the
main unit is not used in a given period of time (5, 10, 20, or 30 minutes).
Thisfunction is useful if you forget to tun off the power.
This function can be set by pressing the [FUNC], [9], and [4] keys, in this order and in the
Home screen.

When this function is active, the “AUTO OFF" mark will be displayed in the upper right
corner of the screen.

m To determine how much more data can be recorded

The main unit has a function to display how much more measurement data can be recorded
for the tag or log on the screen.

To activate this function, press the [FUNC], [3], and [1] keys, in this order and in the Home
screen. Press the [SET] key to display the remaining memory capacity. If the[SET] key is
pressed again, the number of measurement data pieces that can be used with the collector
function, if selected, will be displayed. Furthermore, if the [SET] key is pressed another
time, the number of measurement data pieces that can be used with the logging function, if
selected, will be displayed.

m To see the number of measured data pieces recorded on the tag or log
The main unit has a function to display the number of measured data pieces recorded on the
tag or log.

To activate this function, press the [FUNC], [3], and [3] keys, in this order and in the Home
screen.
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5 Other Useful Functions
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To see the average of the measured data

The main unit has a function to calculate the average of the measured data recorded on the
tags or logs. Thisis useful when pieces of data have been collected and the average is re-
quired.

To activate this function, press the [FUNC], [3], and [2] keys, in this order and in the Home
screen.

Also, to obtain the maximum and minimum values, press the [FUNC], [3], and [2] keys, in
this order and in the Home screen.

To sound a chime at the specified time (the chime function)

The main unit has afunction called the chime function to sound achime at atime specified by the
operator. Thisfunctionissimilar to an darm clock.

The chime can be made to sound so asto signd the operator to start temperature measurement.

To activate this function, press the [FUNC], [6], and [2] keys, in this order and in the Home
screen.

To view the screen in a dark place (the backlight function)

The main unit has a backlight function, which provides alight source so that the operator can
view the screenin adark place. To activatethisfunction, pressthe [FUNC], [9], and [1] keys,
in this order and in the Home screen.

The backlight will be turned off if no operation is performed on the main unit for about 10
seconds.

To turn off the electronically generated sound
The main unit has a function to turn off the key operation sound and the alarm. Use this
function if the electronically generated sound is disturbing you.

To activate this function, press the [FUNC], [9], and [2] keys, in this order and in the Home
screen.
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1 Receiving the Data on the Personal Computer

1 Receiving the Data on the Personal Computer

This section explains the procedure used to receive data, such as measurement
data with the main unit, on the personal computer. The following data items can
be received:

e Measured data associated with tags and logs
e Tag and log setup data
e Operator name data

Received tag and log data can be transferred to Microsoft Excel95 or Microsoft
Excel97 (hereinafter referred to as Excel) when the data is received on the per-
sonal computer.

m Preparation before reception
1. Make sure that the power to the personal computer and main unit is turned off.

2. Connect the personal computer and main unit with the supplied cable.

See Also
For information about connecting the personal computer and main unit, refer to “m Connecting the
personal computer and the main unit” in section 4.1 of the “Preparation for Measurement” part.

3. Turn on the power to the main unit.

See Also
For information about turning on the main unit, refer to “m Turn the power supply to ON” in section 4
of the “Information Required before Use” part.

4. Turn on the power to the main unit.
Now it isready for reception.

-End of procedure-
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1 Receiving the Data on the Personal Computer

m Receiving the data

1. initiate Thermo-Collector software.
The main screen of Thermo-Collector software eill be displayed.

’ Thermo Collector

O]

Propetties...

e [ Ect iew Heb
: . el ] el AL 2

| Setup Tags/Logs - C:\Progiam Files\Thermo Collector\COLLECTOR tmt

Tags |Lugs |

2. Select “Receive” from the “Comm” menu.
A screen for selecting the data to be received will be displayed.

Receive
Contents | Transter |

Specifythe contentwhich i transtered frorm the THERMO
COLLECTOR'"

¥ Measured Datas

¥ Setup TagsiLogs

Start I Cancel

3. Select the data to be received.

[TIP]

The following data items can be received

¢ Measured Datas......... Measured data obtained with the main unit for tags and logs
* Setup Tags/Logs ....... Tags and logs setup data recorded in the main unit

* Setup Persons ........... Measurement operator data
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1 Receiving the Data on the Personal Computer

4. If the received data is to be transferred to Excel, double-click on the “Transfer” tab. If
not, proceed to step 6.
A screen for selecting to which Excel file and in which format the datais transferred will be displayed.
Contents Transferl
Specify how to transfer the measured data to the Microsoft
Excel after receiveing the data.
 Cancel transfer
Sheet Form
 Transfer to the specified file TagiLog Narme j'
|
Hroyses. |
Start I Cancel |
5. When thereis a need to transfer the received measurement data to Excel, select either
"Transfer to the new file" or "Transfer to the specified file".
If “Transfer to the specified file" is selected, click on the "Browse..." tab and select the
Excel file to which the data is transferred. (It is also permitted to enter the specified file
name.) Then, it is allowed to select "Sheet Form" for designating the data format by
which the measurement data is transferred to Excel.
6. click on the [Start] button.
A screen showing the progress of data reception will be displayed. “Comm...” will also be displayed on the screen
of the main unit.
Receiving measured datas . BurgerMo. 4
When data reception has been completed, the received data will be displayed on the personal computer as follows.
’ Thermo Collector | _[Of x|
File Comm Edit “iew Help
|| B2 aa i | = s e R =Y
] Measured Datas _ O] x|
Setup ?
Hi Temperature = +091.0
Burger ‘l Channel=C ) 5 Temperature = +021.0
Mo | Measured Date | heasured Time | Measured Walue| HiJudgement | Lo Judgement | Persan
T : sainiie 15:30:58 26.4 0K 0K Smith
2 99101118 15:39:59 26.0 0K 0K Smith
3 991011 8 15:40:01 25.8 oK 0K Smith
4 99101118 15:40:02 28.4 0K 0K Smith
5 99101118 15:40:02 311 0K 0K Smith
If “Transfer to Excel” is selected in step 5, Excel will automatically be initiated and the received data will be
transferred to Excel.
- End of procedure
IM 54051-E
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2 Outputting Directly from the Main Unit to the Printer

2 Outputting Directly from the Main Unit to the Printer

This section explains the procedure to directly output the data from the main unit
to the printer (Model name: 970 10, optional).

2.1 Output preparation

Before starting output to the printer, confirm that the printer is connected to the main unit
and the setup conditions of the printer.

m Printer-main unit connection

A dedicated cable must be purchased (Model name: 910 10, round DIN 8-pin to D-sub 9-pin
straight cable) to connect the printer and this instrument.

Follow the procedure below to connect the printer and main unit.

1. Turn off the power to the printer.
The power lamp will be turned off.

2. Refer to the following figure to connect the printer to the main unit.
Main unit

% Printer

Power switch T On-line switch

Bottom of the main unit Printer serial port (9-pin)

Round DIN 8-pin to D-sub 9-pin straight cable (optional)

- End of procedure
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2 Outputting Directly from the Main Unit to the Printer

m Confirming the printer setup conditions

1. while holding down the [On-line switch] on the printer, turn on the power to the printer.
The printer setup conditions will be outputted to the printer.

2. Make sure that the contents are identical to that shown in the following figure. If they
are different, correct the setup conditions.

See Also

For information about modifying the printer setup, refer to the operation manual supplied with the

printer.

Dip SW-1
1 (OFF)
2 (ON)
3 (ON)
4 (OFF)
5 (ON)
6 (OFF)
7 (ON)
8 (ON)

Dip SW-2
1 (OFF)
2 (ON)
3 (ON)
4 (ON)
5 (ON)
6 (ON)
7 (ON)
8 (ON)

Dip SW-3
1 (ON)
2 (ON)
3 (ON)
4 (OFF)
5 (OFF)
6 (ON)
7 (ON)
8 (ON)

[DIP SW setting mode]

: Input = Serial

: Printing Speed = High

: Auto Loading = ON

:Auto LF = OFF

: Setting Command = Enable
: Printing

Density
=100%

: Printing Columns = 80

: User Font Back-up = ON

: Character Select = Normal
: Zero = Normal

: International

Character
Set
= Japan

: Data Length = 8 bits

: Parity Setting = No

: Parity Condition = Odd

: Busy Control = XON/XOFF
: Baud

Rate
Select
= 9600 bps

3. Turn off the power to the printer.

- End of procedure
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2 Outputting Directly from the Main Unit to the Printer

2.2 Outputting the measured

76

data to the printer

[TIP]

Connect the main unit and the printer before
turning on the power to the printer. If thisis
not done, the measured data cannot be output-
ted to the printer.

Home screen

| 18:54:27

25.9°C

. Press the [FUNC], [5] and [2] keys, in

this order.

The “1File” screen appears on the LCD.
\PT e

1

| F52

1File

Press the [SET] key.

LOG
INPUT v

. Burger

11

Press the [ ¥] key repeatedly until the
tag or log to be outputted is displayed.
The tag name or log name and the number of pieces
of measured data recorded in the tag or log will be
displayed.

\PT e
. Convey

11

[TIP]

If the[ ] key ispressed repeatedly, “NewTag”
will appear. Existing tags will be displayed
before “NewTag” appears. Existing logs are
displayed after “NewTag” appears.

. Press the [SET] key.

The confirmation screen will appear.

LOG
INPUT

| Print?

Yes1/NoO

. Press the [1] key.

Printout is performed.

[TIP]

To output all the datarecorded on the main unit,
pressthe [FUNC], [5], and [3] keys, in thisor-
der, and then press the [SET] and [1] keys.

Pressthe [ESC] key repeatedly to return to the Home
screen.

- End of procedure

IM 54051-E



2 Outputting Directly from the Main Unit to the Printer

An output example from the printer|

[Burger ] HiAlarm=+80.0 ~ LoAlarm=+60.0

No. Date Temp. Hi Lo Person

00001 98/11/12/11:36:50 Start Smith

00002 98/11/12/11:37:01 56.0 OK NG Smith

00003 98/11/12/11:37:01 575 OK NG Smith

00004 98/11/12/11:37:02 58.5 OK NG  Smith

00005 98/11/12/11:37:03 59.8 OK NG  Smith

00006 98/11/12/11:37:04 61.2 OK OK Smith

00007 98/11/12/11:37:04 62.0 OK OK  Smith

00008 98/11/12/11:37:05 62.0 OK OK Smith

00009 98/11/12/11:37:06 70.0 OK OK Smith

00010 98/11/12/11:37:06 75.0 OK OK  Smith

00011 98/11/12/11:37:07 81.0 NG OK Smith

00012 98/11/12/11:37:07 82.0 NG OK Smith

00013 98/11/12/11:37:15 End Smith
Output example (tag)

[Convey ] Interval=00:00:10

No. Date Temp.

00001 00/00/00/00:00:00 -10.5

00002 00/00/00/00:00:10 -10.5

00003 00/00/00/00:00:20 -11.0

00004 00/00/00/00:00:30 -12.0

00005  00/00/00/00:00:40  -11.5

00006 00/00/00/00:00:50 -11.0

00007 00/00/00/00:01:00 -11.0

00008 00/00/00/00:01:10 -10.7

00009 00/00/00/00:01:20 -10.5

00010  00/00/00/00:01:30  -11.0

00011 00/00/00/00:01:40 -12.0

Output example (log)

IM 54051-E
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m Thermo-Collector specifications

eFeatures

Measuring range and measurement resolution

External probe input channel (A ch)
Measuring range: -20 to 200°C (-4 to 392°F) with aresolution of 0.1 or 1°C (0.1 or 1°F) (using only the dedicated
probe)
Built-in sensor (C ch)
Measuring range: -20 to 50°C (-4 to 122°F) with aresolution of 0.1 or 1°C (0.1 or 1°F)
Emission thermo probe (model: 900 03)
Measuring range: -20 to 400°C (-4 to 752°F) with aresolution of 1°C (1°F)

Accuracy
Accuracy of the external probe input channel (A ch) of the main unit
Measuring range Accuracy
20="C=0(4=F=32) +0.4°C (z0.8°F) __ where the ambient temperature is at 23°C =5°C,
<°C< <°F< +0. +0. (73.4°F +9°F) the humidity is between 20 and
<°C< <°F< +0. +0. 80%RH, and the battery voltageisat 1.5V 0.1V,
<°Cs= <F= = =1, and excludes the accuracy of the probe.
Accuracy of the built-in sensor (C ch)
Measuring range Accuracy
-20=°C<0(-4<°F<32) +1.0°C (+1.8°F)  where the ambient temperature is at 23°C +5°C,
0<°C<40 (32 < F = 104) 208C (+15F) (73.4°F +9°F) the humidity is between 20 and

80%RH, and the battery voltageisat 1.5V 0.1V,
40 <°C<°50 (104 < °F < 122) +1.0°C (+1.8°F)  and using a thermistor as the sensor.

Accuracy (indication accuracy) of the radiation probe data input channel (D ch)
Theindication accuracy for aradiation probe (model: 900 03) that can be connected to Thermo-Collector is+1°C
(+1°F), excluding errors involved in the radiation temperature probe itself (Refer to the radiation temperature
probe specifications).

Characteristics

Effects from ambient temperature
A ch: Within ((+0.3°C/10°C) =1 digit) (Within ((+0.6°F/18°F) +1 digit)). For the accuracy of C ch, refer to thetable
(Accuracy of the built-in sensor (C ch)) as shown above.

Effects from battery voltage drop
While the battery voltage alarm is off: Within +1 digit

Battery life
Approx. 2 weeks (while the collector function is on, for eight hours of measurement per day and 30 minutes of
communication)
Approx. 1 month (while the logging function is on and measurement is at 1-minute intervals)
Approx. 3 months (while the logging function is on and measurement is at 10-minute intervals)

* The battery life depends on the battery quality and measurement environment. The maximum lives shown the
above are those which measured with an LR6 alkaline dry cell under aroom temperature.

&unctions

Measurement mode and interval

Collector mode
While the [LOG] sign is off, measurements will be saved in the internal memory if the [Memory] key is pressed
under a condition where an optional tag is being displayed on the screen. A tag name must consist of maximum
eight alphanumeric characters. The maximum number of tagsis50. The measurement interval should be 1 second
or longer. A measurement operator name must consist of maximum eight al phanumeric characters. The maximum
number of operatorsis 10.
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Logging mode
While the [LOG] sign is on, measurements will be saved in the internal memory if the [Memory] key is pressed
under a condition where an optional log is being displayed on the screen. A log name must consist of maximum
eight alphanumeric characters. The maximum number of logs is 10. The measurement period depends on the
remaining capacity of the internal memory. The measurement interval should be greater than 1 second and less
than 24 hours.

Capacity of the internal memory
5000 pieces of data with the collector function solely. If using only the logging function, the maximum data
capacity is 20000 pieces.
However, the measured data collected either with the collector function or with the logging function can co-exist
in the internal memory.

Display
Semi-transmission type liquid crystal display (LCD)
8 characters x 2 lines dot matrix display section and icon display section
Display light
Two backlight LEDs for the display section. 10 seconds of duration from the moment when any key is operated
(factory setting: OFF).
Clock function
Controls the date (internal data) and time (internal data and display). The accuracy iswithin 1 minute per month.

Alarm function
This function can be set to the upper-limit temperature and lower-limit temperature. In both cases, it can be set so
either the alarm is turned on if the temperature falls within or outside the specified range.

Calculation function
Can obtain the maximum temperature (MAX), minimum temperature (MIN), and average (AVE).

Key operation sound function
Possible to set on or off of the buzzer sound when the keys are operated (factory setting: ON).

Auto Power Off function
Selectable from 5, 10, 20, and 30 minutes or infinite (factory setting: 10 minutes).

Low battery voltage alarm
A battery symbol turns on if the set LR6 akaline dry cell almost expires.

Auto Operation Stop at a low battery voltage
When the set LR6 alkaline dry cell is almost used up, the system power will be automatically turned off after the
“BatteryEmpty” message appears.
Do not |eave the used battery being set in the main unit. This may cause operation errors or battery liquid leakage.

Back-up function
Used to back up the measurement data or clock function when the regular LR6 alkaline dry cell is not installed.
The back-up battery has a capacity to retain data for typically six years under the room temperature (23+5°C).

Key lock and FUNC lock
Disables the operation keys and function keys other than the Power key (factory setting: OFF).

Specification of the number of display digits
The user can specify whether the least significant digit of temperature display is the first decimal position (i.e.
0.1°C (0.1°F)) or first integer (i.e. 1°C (1°F)). (factory setting: 0.1°C (0.1°F))
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Drip-proof

Protection class: |P54
P54
— Drip-proof (protection for being subjected to splash)
Dust-proof (protection for being subjected to dust)
Protection characteristic symbol (International Protection)
Communication function

RS-232C communication function
« Electrical characteristics ..... Conforms to EIA RS-232C standard

* Baudrate........ .. 1200, 2400, 4800, 9600, 19200 [bps]
Data length .. 7, 8 [hit]
Parity Odd parity (odd), Even parity (even), or None (None)

1, 2[bit]
.. Hardware handshake (RTS, CTS) or no flow control
Round DIN connector with 8 pins (requires a dedicated cable)

Stop bit
Flow control ..
Connector

*The underline shows the factory settings.

Control lines Connector pin assignment
Pin No. Signal line name

1 CTS (Clear to Send)

2 RXD (Received Data)

3 RTS (Request to Send)

4 TXD (Transmitted Data)

56 (N.C)

7 (SENS) *Note

8 SG (Signal Grounding)

Note: Pin No.7 senses if the RS-232C Connector is plugged.
Thisis connected to No.8 pin of the dedicated cable.

Digital serial communication function (Note: thisis not a USB port)
The digital serial 1/0 port (D ch) is capable of logging the radiation temperature probe data.

€xternal dimensions

Approx. 133 (H) x 56 (W) x 33 (D) mm (excluding the projecting sections)
eNeight

Approx. 170 g (including two standard LR6 alkaline dry cells)

Battery (reccommeded)
LR6 akaline dry cell, 1.5V x 2

Operation and storage enviroment
Operation temperature/humidity range: -20 to 50°C (-4 to 122°F), 20 to 80%RH (without condensation)
Storage temperature/humidity range: -30 to 60°C (-22 to 140°F), 5 to 95%RH (without condensation)
The operation and storage environment must be free from organic solvent or corrosive gases.

dAccessories

Instruction manual (including the descriptions of the application software) 1 copy
LR6 akaline dry cell 2 units
Application software (on 1.44 MByte floppy diskette) 2 diskettes
Dust-proof seal (for sealing the screw holes on the back face of the main unit) 2 pieces
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€xternal probe (optional) specifications

Standard needle probe (Model: 900 10) *NOTE
Measuring range: -20 to 200°C (-4 to 392°F)

Range Accuracy
~20= °C =0 (-4= °F =32) =05°C (TYP) z0.9°F (TYP))
0< °C <100 (32< °F <212) +0.5°C (MAX) (<0.9°F (MAX))

100< °C < 150 (212< °F <302)  =1.0°C (TYP) (=1.8°F (TYP))
150< °C <200 (302< °F <392) +2.0°C (TYP) (+3.6°F (TYP))

High speed needle probe (Model: 900 11) *NOTE
Measuring range: -20 to 200°C (-4 to 392°F)
Range Accuracy
-20=< °C <150 (-4< °F <302) +15°C(TYP) (:2.7°F (TYP))
150< °C =200 (302< °F <392) +25°C (TYP) (x4.5°F (TYP))
Surface probe (Model: 900 12) *NOTE
Measuring range: -20 to 200°C (-4 to 392°F)
Range Accuracy
-20=< °C <150 (-4< °F <302) +15°C(TYP) (:2.7°F (TYP))
150< °C =200 (302< °F <392) +25°C (TYP) (x4.5°F (TYP))
Rounded end probe (Model: 900 13) *NOTE
Measuring range: -20 to 200°C (-4 to 392°F)

Range Accuracy
20= °C <0 (-4= F <32) 20.5°C (TYP) (z0.9°F (TYP))
0< °C <100 (32< °F <212) +0.5°C (MAX) (=0.9°F (MAX))

100= °C < 150 (212=< °F <302) +1.0°C (TYP) (+1.8°F (TYP))
150< °C <200 (302< °F <392) +2.0°C (TYP) (+3.6°F (TYP))
Emission thermo probe (Model: 900 03)
Measuring range: -20 to 200°C (-4 to 392°F)
Accuracy : Measurement temperature +1%=+1°C or +3°C of the indication whichever is greater.

*NOTE : The external probe assumes the condition where it is dipped in the liquid being mixed to a half
dimension of the temperature measurement section.
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&xternal view and dimensions

33

29

133

| [ \S

RS232C

Unit: mm
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m Operation environment of Thermo-Collector software
:1486DX or higher

: Windows95/Windows98/WindowsNT4.0
: 3.5", 1.44 MB-formatted

CPU
os
FDD

Required space on the HDD

Recommended memory capacity :

Serial 1/0 capability

Software

:10 MB or greater

16 MB or greater
:A serial port conforming to RS-232C standard should be available.

:Microsoft Excel95, Microsoft Excel97

m Function keys quick reference

Menu No.| Menu [SubmenuNof Submenu Description
1 Curr Tag | Confirming the tag
2 TagChnge | Modifying the tag name
1 Tag Set N
3 Tag Ins Inserting a tag
4 Tag Del Clearing the tag
1 Curr Log | Confirming the log
2 LogChnge | Modifying the log name
2 Log Set 3 Log Ins Inserting a log
4 Log Del Clearing the log
5 Reserve | Timer function
1 Capacity | Confirming the remaining memory capacity
3 CurrData 2 Calc Confirming the maximum/minimum/average data
3 Measure | Confirming the number of tag data/log data pieces
1 1TagFile | Clearing the measured data associated with the tag
2 1LogFile | Clearing the measured data associated with the log
4 Data Clr 3 1TagData | Clearing one piece of measured data associated
with the tag/log
4 A1l File Clearing all measurement data
1 Comm Set | Setting the communication environment
5 Comm 2 1File Outputting the tag/log data for the printer
3 All File Outputting all data for the printer
1 ClockSet | Setting the date and time
6 Clock 2 ChimeSet | Setting the chime function to ON/OFF and the time
at which it is turned on/off.
1 All File Batch-setting the alarm function for all tags
7 AlarmSet " . - =
2 1File Setting the alarm function for the specified tags
1 CurrData | Confirming the currently selected operator
8 Staff 2 Change Modifying the operator
3 Entry Registering the operator name
1 BkLight Backlight ON/OFF
2 KeySound | Key operation sound ON/OFF
3 Digit On/Off of the temperature fraction display
9 Others 4 APOff Setting the Auto Power Off function
5 KeyLock | Key lock ON/OFF
6 FuncLock | FUNC lock ON/OFF
7 Name Setting the instrument name
0 Initial 1 Initial Initializing the setup data and measured data
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YOKOGAWA ¢

Yokogawa M&C Corporation

YOKOGAWA M&C CORPORATION

International Sales Dept.

Musashino Center Bldg.

1-19-18 Nakacho, Musashino-shi, Tokyo, 180-0006 Japan
Phone: 81-422-55-8755 Facsimile: 81-422-55-8954
YOKOGAWA CORPORATION OF AMERICA (U.S.A.)

Phone: 1-770-253-7000 Facsimile: 1-770-251-2088
YOKOGAWA EUROPE B. V. (THE NETHERLANDS)

Phone: 31-334-64-1611 Facsimile: 31-334-64-1610
YOKOGAWA AMERICA DO SUL S. A. (BRAZIL)

Phone: 55-11-7295-1433 Facsimile: 55-11-5522-5231
YOKOGAWA ENGINEERING ASIA PTE. LTD. (SINGAPORE)
Phone: 65-241-9933 Facsimile: 65-241-2606

YOKOGAWA MEASURING INSTRUMENTS KOREA CORPORATION (KOREA)
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